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1 HP Photosmart C7200 All-in-
One series Help

For information about the HP All-in-One, see:

* “HP All-in-One overview” on page 11

* “Find more information” on page 23

* “Finish setting up the HP All-in-One” on page 25
*  “How do I?” on page 69

» “Load originals and load paper” on page 71
*  “Print from your computer” on page 83

» “Use the photo features” on page 101

* “Use the scan features” on page 115

*  “Use the copy features” on page 121

+  “Use the fax features” on page 131

*  “Print reports and forms” on page 149

*  “Maintain the HP All-in-One” on page 155
»  “Shop for ink supplies” on page 167

« “HP warranty and support” on page 279

* “Technical information” on page 287
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2 HP All-in-One overview

Use the HP All-in-One to quickly and easily accomplish tasks such as making a copy,
scanning documents, sending and receiving faxes, or printing photos from a memory
card. You can access many HP All-in-One functions directly from the control panel,
without turning on your computer.

This section contains the following topics:
* The HP All-in-One at a glance

»  Control panel overview

* Menu overview

* Text and symbols
* Use the HP Photosmart Software

The HP All-in-One at a glance

Label Description

Overview

1 Automatic document feeder

2 Color graphics display (also referred to as the
display)

Output tray

Paper-width guide for the main input tray

Main input tray (also referred to as the input tray)

[~ TS B A ]

Paper tray extender (also referred to as the tray
extender)

HP All-in-One overview 11



Chapter 2
(continued)

Label Description

7 Paper-width and paper-length guides for the
photo tray

8 Paper-length guide for the main input tray

9 Photo tray

10 Ink cartridge door

11 Front USB port for your camera or other storage
device

12 Memory card slots and Photo light

13 Control panel

14 Glass

15 Lid backing

16 Ethernet port

17 Rear USB port

18 Power connection’

19 1-LINE (fax) and 2-EXT (phone) ports

20 Two-sided printing accessory

*  Use only with the power adapter supplied by HP.

Control panel overview
This section describes the functions of the control panel buttons and lights, as well as the
icons and sleep state on the display.
This section contains the following topics:
* Control panel features

» Display icons
» Display sleep state

o
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Control panel features

The following diagram and related table provide a quick reference to the HP All-in-One
control panel features.

27120120124 )3 oY 21 ) 2019

Overview

Label Name and Description

1 Display: Displays menus, photos, and messages. The angle of the display can be changed for
better viewing. Place a finger in the indented area to the left of the display and then pull up.

2 Attention light: Indicates a problem occurred. See the display for more information.

3 Back: Returns to the previous screen on the display.

4 Directional pad: Allows you to navigate through menu options by pressing the up, down, left,
or right arrow buttons.

If you are zooming in on a photo, you can also use the arrow buttons to pan around the photo
and select a different area to print.

5 OK: Selects a menu setting, value, or photo on the display.

6 Zoom out - (magnifying glass icon): Zooms out to show more of a photo. If you press this button
when a photo is shown on the display at 100%, the Fit to Page feature is applied to the photo
automatically.

7 Zoom in + (magnifying glass icon): Zooms in to enlarge the image on the display. You can also
use this button together with the arrows on the directional pad to adjust the crop box for
printing.

8 Photo Menu: Launches the Photosmart Express menu for printing, saving, editing, and
sharing photos.

9 Red Eye Removal: Turns the Red Eye Removal feature On or Off. By default, this feature is
turned off. When the feature is turned on, the HP All-in-One automatically corrects red eye
coloring in the photo currently shown on the display.

10 Copy Menu: Opens the Copy Menu where you can select copy options, such as number of
copies, paper size, and paper type.

11 Reprints: Enables you to make a copy of an original photo placed on the glass.

Control panel overview 13



Chapter 2
(continued)

Label Name and Description

12 Fax Menu: Presents the Enter Fax Number screen to enter a fax number. If you press it again,
the Fax Menu appears where you can select fax options.

13 Auto Answer: When this button is lit, the HP All-in-One automatically answers incoming phone
calls. When off, the HP All-in-One does not answer any incoming fax calls.

14 Keypad: Enters fax numbers, values, or text.

15 On: Turns the HP All-in-One on or off. When the HP All-in-One is off, a minimal amount of power

is still supplied to the device. You can further reduce power supply by holding down the On
button for 3 seconds. This places the HP All-in-One in Federal Energy Management Program
(FEMP) mode. To completely remove power, turn the HP All-in-One off, and then unplug the

power cord.
16 Wireless radio light: Indicates that the 802.11 b and g wireless radio is turned on.
17 Space and #: Enter spaces and pound signs for fax-related tasks.

Symbols and *: Enter symbols and asterisks for fax-related tasks.

18 Start Fax Color: Starts a color fax.

19 Start Fax Black: Starts a black-and-white fax.

20 Scan Menu: Opens the Scan Menu where you can select a destination for your scan.

21 Start Copy Color: Starts a color copy.

22 Start Copy Black: Starts a black-and-white copy.

23 Print Photos: Depending on whether you access your photos from the View, Print, or Create

menu, the Print Photos button will display the Print Preview screen or it will print any selected
photo(s). If no photos are selected, a prompt appears asking if you want to print all the photos
on your card or storage device.

24 Cancel: Stops the current operation.

25 Setup: Presents the Setup Menu for generating reports, changing fax and network settings,
and accessing tools and preferences.

26 Help: Opens the Help Menu menu on the display where you can select a topic to learn more
about it. Depending on the topic you select, the topic will appear on your display or on your
computer screen.

From the idle state, pressing Help lists a menu of items for which the user can obtain help. When
viewing screens other than Idle, the Help button provides context sensitive help.
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Display icons

The following icons can appear at the bottom of the display to provide important
information about the HP All-in-One.

Icon Purpose

Shows the ink cartridge status. The color of the icon corresponds to the color of
the ink cartridge, and the fill level of the icon corresponds to the fill level of the
ink cartridge.

14 HP All-in-One overview



(continued)

Icon Purpose

NOTE: The ink level icons will only appear if one of the ink cartridges is less
than 50% full. If the ink level for all ink cartridges is more than 50% full, the ink
cartridge icons do not appear on the display.

Shows that the ink cartridge is nearly empty, and will need to be replaced.

Shows that an unknown ink cartridge is inserted. This icon might appear if an
ink cartridge contains non-HP ink.

Shows the wired network connection status.

If the Auto Answer icon is showing on the display, the HP All-in-One will receive
faxes automatically. If there is no icon showing, you will have to receive faxes
manually.

Indicates the presence and signal strength of a wireless network connection.

Indicates the presence of an Ad hoc wireless network connection.

Indicates that an HP bt450, Printer and PC Adapter with Bluetooth® Wireless
Technology is connected to the front USB port.

Display sleep state

To prolong the life of the display, it dims after two minutes of inactivity. After 30 minutes
of inactivity, the display goes into a sleep state and the screen shuts off completely. The
display turns back on when you press a control panel button, insert a memory card or
connect a storage device, lift the lid, or access the HP All-in-One from a connected
computer.

Overview

Menu overview
The following topics provide a quick reference to top-level menus that appear on the
HP All-in-One display.
* Photosmart Express Menu

+  Copy Menu
* Scan Menu

« Fax Menu

Menu overview 15
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+ Setup Menu
* Help Menu

Photosmart Express Menu

The following options are available in the Photosmart Express menu when you insert a
memory card or storage device, or when you press Photo Menu on the control panel.

View

Print Create Share Save

Copy Menu

The following options are available when you press the Copy Menu button on the control
panel.

Copies

Size

Quality
Lighter/Darker
Preview

o
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Crop

Paper Size

Paper Type

Margin Shift
Enhancements

Set As New Defaults
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Scan Menu

The following options are available when you press the Scan Menu button on the control
panel.

Bf NOTE: The applications that appear on the Scan Menu vary depending on the
software applications installed on your computer.

Scan and Reprint
Scan to Memory Card
HP Photosmart Premier

Scan to Computer

Br NOTE: The Scan to Computer option only appears if the HP All-in-One is network-
connected.

Fax Menu

When you press the Fax Menu button, the Enter Fax Number screen appears where
you can enter a fax number.

If you press the Fax Menu button again, the Fax Menu appears where you can change
the following fax options.

Resolution
Lighter/Darker

Scan and Fax
Broadcast Fax

Send Fax Later

Poll to Receive

Set As New Defaults

Setup Menu
The following options are available when you press the Setup button on the control panel.

Printable School Papers
Print Report
Speed Dial Setup

Overview

Basic Fax Setup
Advanced Fax Setup
Network

Tools

Preferences

Bluetooth Menu

Menu overview 17
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Bf NOTE: The Bluetooth Menu option only appears if an optional HP bt450, Printer
and PC Adapter with Bluetooth® Wireless Technology is attached to the HP All-in-
One.

Help Menu

The Help Menu menu provides quick access to key help topics and is available when
you press the Help button. If you select one of the first six topics, the help appears on
the display. If you select one of the last six topics, the help appears on your computer.
The following options are available.

Use Control Panel

Insert Ink Cartridges
Load Paper in Photo Tray
Load Paper

Load Original on Scanner
Icon Glossary

How Do |

Error Messages

General Troubleshooting
Networking Troubleshooting
Use Memory Card

Get Support

Text and symbols

You can enter text and symbols from the control panel by using the visual keyboard. It
appears automatically on the display when setting up a wired or wireless network, the fax
header information, or speed dial entries. You can also use the keypad on the control
panel to enter text and symbols.

You can also enter symbols from the keypad when you dial a fax or phone number. When
the HP All-in-One dials the number, it will interpret the symbol and respond accordingly.
For example, if you enter a dash in the fax number, the HP All-in-One will pause before
dialing the remainder of the number. A pause is useful if you need to access an outside
line before dialing the fax number.
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Bf NOTE: If you want to enter a symbol in your fax number, such as a dash, you need
to enter the symbol by using the keypad.

This section contains the following topics:

» Enter text using the keypad on the control panel
» Enter text using the visual keyboard

* Available symbols for dialing fax numbers

Enter text using the keypad on the control panel
You can enter text or symbols by using the keypad on the control panel.

18 HP All-in-One overview



To enter text

1. Press the keypad numbers that correspond to the letters of a name. For example, the
letters a, b, and c correspond to the number 2, as shown on the button below.

{} TIP: Press a button multiple times to see the available characters. Depending
on your language and country/region setting, other characters might be available
in addition to the ones shown on the keypad.

2. After the correct letter appears, wait for the cursor to advance automatically to the
right, or press p. Press the number that corresponds to the next letter in the name.
Press the button multiple times until the correct letter appears. The first letter of a
word is automatically set to uppercase.

To enter a space, pause, or symbol

A Toinsert a space, press Space.
To enter a pause, press Symbols repeatedly until a dash appears.
To enter a symbol, such as @, press the Symbols button repeatedly to scroll through
the list of available symbols: asterisk (*), dash (-), ampersand (&), period (.), slash
(), parentheses ( ), apostrophe ('), equals (=), number sign (#), at (@), underscore
(L), plus (+), exclamation (1), semicolon (;), question (?), comma (,), colon (:), percent
(%), and approximation (~).

To erase a letter, number, or symbol
A If you make a mistake, press « to clear it, and then make the correct entry.

After you are done entering text, press OK to store your entry.

Enter text using the visual keyboard

You can enter text or symbols by using the visual keyboard that automatically appears
on the display when you need to enter text. For example, the visual keyboard
automatically appears when you are setting up a wired or wireless network, the fax header
information, or speed dial entries.

O TIP: You can also enter text and numbers using the visual keyboard by using the
keypad on the control panel of the HP All-in-One. Press a button numerous times to
access additional letters. For instance, press 2 three times to enter the letter C.

Overview
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To enter text using the visual keyboard

1. To select a letter, number, or symbol in the visual keyboard, press 4, p>, A, and
WV to highlight the appropriate selection.

To enter lowercase letters, uppercase letters, numbers, and symbols

+ Toenterlowercase letters, select the abe button on the visual keyboard, and then
press OK.

« To enter uppercase letters, select the ABC button on the visual keyboard, and
then press OK.

+ To enter numbers, select the 123 button on the visual keyboard, and then press
OK.

« To enter symbols, select the .@! button on the visual keyboard, and then press
OK.

2. After you highlight the appropriate letter, number, or symbol, press OK on the control
panel to select it.
The selection appears on the display.

{'} TIP: To erase a letter, number, or symbol, select Clear on the visual keyboard,
and then press OK.

3. When you are finished entering text, numbers, or symbols, select Done on the visual
keyboard, and then press OK.

Available symbols for dialing fax numbers

20

To enter a symbol, such as *, press Symbols repeatedly to scroll through the list of
symbols. The following table provides the symbols that you can use in a fax or phone
number sequence, fax header information, and speed dial entries.

Available Description Available when entering
symbols
* Displays an asterisk symbol when Fax header name, speed dial
required for dialing. names, speed dial numbers, fax or
phone numbers, and monitor dial
entries
- When auto-dialing, the HP All-in-One Fax header name, fax header
enters a pause in the number sequence. | number, speed dial names, speed
dial numbers, and fax or phone
numbers
() Displays a left or right parenthesis to Fax header name, fax header
separate numbers, such as area codes, number, speed dial names, speed
for easier reading. These symbols do not | dial numbers, and fax or phone
affect dialing. numbers
w When auto-dialing, W causes the HP All- | Speed dial numbers and fax or
in-One to wait for a dial tone before phone numbers
continuing to dial.
R During auto-dialing, the R functions the Speed dial numbers and fax or
same as a Flash button on your telephone. | phone numbers

HP All-in-One overview



(continued)

Available Description Available when entering
symbols
+ Displays a plus symbol. This symbol does | Fax header name, fax header
not affect dialing. number, speed dial names, speed
dial numbers, and fax or phone
numbers

Use the HP Photosmart Software

The HP Photosmart Software provides a fast and easy way to make prints of your photos.
It also provides access to other basic HP imaging software features, such as saving and
viewing your photos.

For more information on using the HP Photosmart Software:

» Check the Contents panel on the left. Look for the HP Photosmart Software Help
contents book at the top.

= Ifyou do not see the HP Photosmart Software Help contents book at the top of the
Contents panel, access the software help through the HP Solution Center.

Overview
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3 Find more information

You can access a variety of resources, both printed and onscreen, that provide
information about setting up and using the HP All-in-One.

Setup Guide

The Setup Guide provides instructions for setting up the HP All-in-One and
installing software. Make sure you follow the steps in the Setup Guide in order.

If you have problems during setup, check the Setup Guide for troubleshooting
information, or see “Troubleshooting” on page 169 in this onscreen Help.

HP Photosmart 3300 Allin O s

R

Basics Guide

The Basics Guide contains an overview of the HP All-in-One, including step-
by-step instructions for basic tasks, troubleshooting tips, and technical
information.

HP Photosmart Essential animations

The HP Photosmart Essential animations are an interactive way to get a brief
overview of the software included with the HP All-in-One. You will learn how the
software can help you create, share, organize, and print your photos.

Onscreen Help

The onscreen Help provides detailed instructions on using all features of the
HP All-in-One.

«  The How Do I? topic provides links so you can quickly find information on
performing common tasks.

«  The HP All-in-One overview topic provides general information about the
main features of the HP All-in-One.

«  The Troubleshooting topic provides information about resolving errors
you might encounter with the HP All-in-One.

Readme

The Readme file contains the most recent information which might not be found
in other publications.

Install the software to access the Readme file.

www.hp.com/support

If you have Internet access, you can get help and support from the HP Web
site. This Web site offers technical support, drivers, supplies, and ordering
information.

Find more information 23
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4 Finish setting up the HP All-in-
One

After you have completed the steps in your Setup Guide, refer to this section to help you
finish setting up the HP All-in-One. This section contains important setup-related
information for your device, including information on setting preferences.

This section contains the following topics:

* Set your preferences
»  Computer connection information
* Connect to a network

* Faxsetup

Set your preferences

You can change the settings on the HP All-in-One so that it behaves according to your

preference. For example, you can set general device preferences, such as the language
used to display messages and the date and time on the display. You can also restore the
device settings to what they were when you purchased your device. This will erase any
new defaults you have set.

This section contains the following topics:
*  General preferences
» Fax preferences

General preferences

Before you begin using the HP All-in-One, you should review and, if necessary, adjust
the general device settings described in this section.

This section contains the following topics:

» Set your language and country/region

» Set the date and time

* Adjust the volume

» Set the default paper tray for PictBridge/DPOF/uPnP printing
» Enable faster browsing of photos

« Set the paper tray for printing from a Bluetooth device

» Restore the factory defaults

» Play a slideshow on the display

Set your language and country/region

The language setting determines which language the HP All-in-One uses to show
messages on the display. The country/region setting determines the default paper sizes
and layouts for printing. You can change these settings at any time by using the following
procedure.
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To set your language and country/region

1. Press Setup.

2. Press ¥ to highlight Preferences, and then press OK.
3. Press ¥ to highlight Set Language, and then press OK.
4

Press ¥ to scroll through the languages. When the language you want to use
appears, press OK.

When prompted, press ¥ to highlight Yes or No, and then press OK.
Press ¥ to highlight Set Country/Region, and then press OK.

7. Press ¥ to scroll through the countries/regions. When the country/region you want
to use appears, press OK.

8. When prompted, press ¥ to highlight Yes or No, and then press OK.

o,

Set the date and time

You can set the date and time from the control panel. The date and time format is based
on the language and country/region setting. When you send a fax, the current date and
time are transmitted, along with your name and fax number, as part of the fax header.

Bf NOTE: In some countries/regions, the date and time stamp on the fax header is a
legal requirement.

The HP All-in-One has a battery-powered clock so the date and time setting is not lost
when the device is unplugged.

To set the date and time
1. Press Setup.
2. Press ¥ to highlight Tools, and then press OK.
3. Press ¥ to highlight Date and Time, and then press OK.
4. Enter the month, day, and year by pressing the appropriate numbers on the keypad.
Depending on your country/region setting, you might enter the date in a different
order.
Enter the hours and minutes.
6. If your time is displayed in the 12-hour format, press 1 for AM, or 2 for PM.
The new date and time settings appear on the display.

o

Adjust the volume

You can adjust the volume of different aspects of the HP All-in-One, including the sounds
associated with device events, errors, and fax tones.

To adjust the volume sound effects

1. Press Setup.

2. Press V¥ to highlight Preferences, and then press OK.

3. Press ¥ to highlight Sound Effects Volume, and then press OK.
4

Press ¥ to highlight Soft, Loud, or Off, and then press OK to select the volume you
want.
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To adjust the volume of fax sounds

1. Press Setup.

2. Press ¥ to highlight Basic Fax Setup, and then press OK.

3. Press ¥ to highlight Fax Sound Volume, and then press OK.

4. Press ¥ to highlight one of the options: Soft, Loud, or Off, and then press OK.

Bf NOTE: If you select Off, you will not hear a dial tone, fax tones, or incoming ring
tones. With the Fax Sound Volume set to Off, you cannot send a fax using
monitor dialing, such as when using a calling card to send a fax.

Related topics
“Send a fax using monitor dialing” on page 134

Set the default paper tray for PictBridge/DPOF/uPnP printing

Set the default paper tray to use when you print photos from a Pictbridge device, DPOF
file, or a UPnP device. The default setting is Photo Tray.

To set the default paper tray

1. Press Setup.

2. Press ¥ to highlight Preferences, and then press OK.

3. Press ¥ to highlight PictBridge/DPOF/uPnP Tray Select, and then press OK.
4

Press ¥ or A to highlight Main Tray or Photo Tray, and then press OK to select the
tray you want.

Enable faster browsing of photos

You can set up the HP All-in-One to enable faster photo browsing by writing small
thumbnails to the memory card. The thumbnails take up a relatively small amount of
space and are used to speed up the browsing performance of photos on the card.

BY NOTE: This feature is on by default.

To turn faster browsing on or off

1. Press Setup.

2. Press ¥ to highlight Preferences, and then press OK.

3. Press ¥ to highlight Enable Faster Photo Browsing, and then press OK.
4. Press ¥ or A to highlight On or Off, and then press OK.

Set the paper tray for printing from a Bluetooth device

Set the default paper tray to use when you print photos from a Bluetooth device.
To set the paper tray for printing from a Bluetooth device

1. Press Setup.
2. Press ¥ to highlight Bluetooth, and then press OK.
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3. Press ¥ to highlight Bluetooth Tray Select, and then press OK.
4. Press ¥ to highlight Main Tray or Photo Tray, and then press OK.

Restore the factory defaults

You can restore the current settings to what they were when you purchased the HP All-
in-One.

Bf NOTE: Restoring the factory defaults will not affect any changes you made to scan
settings and the language and country/region settings.

You can perform this process from the control panel only.

BY NOTE: Restoring the factory defaults does not erase any information you entered,
such as the date and time and the fax header. It also does not delete any information
saved to memory, such as the fax log and caller ID history.

To restore the factory defaults
1. Press Setup.
2. Press ¥ to highlight Tools, and then press OK.

3. Press ¥ to highlight Restore Factory Defaults, and then press OK.
The factory default settings are restored.

Play a slideshow on the display

You can set up the HP All-in-One to play a slideshow on the display, similar to a
screensaver on a computer, when you are not using the device.

There are two types of slideshows that you can enable:

« Store Demo: appears after the HP All-in-One is inactive for one minute and shows a
set of predefined graphics that describe features of the device. The slideshow plays
until you press a button or use the device. If the HP All-in-One remains inactive for
eight hours, the display turns off.

BY NOTE: HP recommends leaving Store Demo off.

» Tips Slideshow: appears only after you print from the computer. The HP All-in-One
shows a set of predefined slides with information about special features that you can
do with the device. The slideshow plays through once and then the display returns to
the main menu.

To turn the store demo on or off

1. Press Setup.

2. Press ¥ to highlight Tools, and then press OK.

3. Press ¥ to highlight Store Demo, and then press OK.

4. Press ¥ or A to highlight On or Off, and then press OK.

To turn the tips demo on or off
1. Press Setup.
2. Press V¥ to highlight Tools, and then press OK.
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3. Press ¥ to highlight Tips Slideshow, and then press OK.
4. Press ¥ or A to highlight On or Off, and then press OK.

Fax preferences

You should review the information in the Fax setup section of the printed documentation
to find out the recommended settings for the options described in the following topics.
The recommended settings depend on how you set up the HP All-in-One for faxing with
the other equipment and services that you might have on the same phone line as the
HP All-in-One.

Bf NOTE: Before setting the fax preferences described in this section, make sure you
have set the language/country/region and date/time preferences.

This section contains the following topics:

«  Set up the HP All-in-One to redial a fax number automatically
* Set tone or pulse dialing

» Set the fax speed

Related topics

+ “Fax setup” on page 61
*  “General preferences” on page 25

Set up the HP All-in-One to redial a fax number automatically

You can set the HP All-in-One to redial a busy or an unanswered number automatically.
The default Busy Redial setting is Redial. The default No Answer Redial setting is No
Redial.

To set redial options from the control panel
1. Press Setup.
2. Do one of the following:

To change the Busy Redial setting
a. Press ¥ to highlight Advanced Fax Setup, and then press OK.
b. Press V¥ to highlight Busy Redial, and then press OK.

To change the No Answer Redial setting
a. Press ¥ to highlight Advanced Fax Setup, and then press OK.
b. Press ¥ to highlight No Answer Redial, and then press OK.

3. Press ¥ to highlight Redial or No Redial, and then press OK.

Set tone or pulse dialing
You can set the dial mode for the HP All-in-One to either tone dialing or pulse dialing.

Most telephone systems work with either type of dialing. If your telephone system does
not require pulse dialing, HP recommends using tone dialing. If you have a public
telephone system or a private branch exchange (PBX) system, you might need to select
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Pulse Dialing. Contact your local telephone company if you are unsure which setting to
use.

E¥ NOTE: If you select Pulse Dialing, some phone system features might not be
available. It can also take longer to dial a fax or phone number.

NOTE: This feature is not supported in all countries/regions. If it is not supported in
your country/region, Tone or Pulse Dialing does not appear in the Basic Fax
Setup menu.

To set tone or pulse dialing from the control panel

1. Press Setup.

2. Press ¥ to highlight Basic Fax Setup, and then press OK.

3. Press ¥ to highlight Tone or Pulse Dialing, and then press OK.

4. Press V¥ to select Tone Dialing or Pulse Dialing, and then press OK.

Set the fax speed

You can set the fax speed used to communicate between the HP All-in-One and other
fax machines when sending and receiving faxes. The default fax speed varies by country/
region.

If you use one of the following, setting the fax speed to a slower speed might be required:
* An Internet phone service
A PBXsystem

Fax over Internet Protocol (FolP)

An integrated services digital network (ISDN) service

If you experience problems sending and receiving faxes, you might want to try setting the
Fax Speed setting to Medium (14400) or Slow (9600).

To set the fax speed from the control panel

1. Press Setup.

2. Press ¥ to highlight Advanced Fax Setup, and then press OK.

3. Press ¥ to highlight Fax Speed, and then press OK.

4. Press V¥ to select one of the following settings, and then press OK.

Fax speed setting Fax speed

Fast (33600) v.34 (33600 baud)
Medium (14400) v.17 (14400 baud)
Slow (9600) v.29 (9600 baud)

Computer connection information

The HP All-in-One comes equipped with a USB port so you can connect directly to a
computer using a USB cable. You can also connect the HP All-in-One to either a wired
or wireless network. If you insert an HP bt450, Printer and PC Adapter with Bluetooth®

30 Finish setting up the HP All-in-One



Wireless Technology into the front USB port, Bluetooth® devices such as PDAs and
camera phones can print to the HP All-in-One.

BY NOTE: In the remainder of this chapter, the HP bt450, Printer and PC Adapter with
Bluetooth® Wireless Technology is referred to simply as an HP bt450.

This section contains the following topics:

e Supported connection types

e Connect using Ethernet

* Connect using integrated wireless WLAN 802.11

e Connect using the HP bt450, Printer and PC Adapter with Bluetooth® Wireless

Technology
e Use printer sharing

Supported connection types

Description

Recommended number
of connected
computers for best
performance

Supported software
features

Setup instructions

USB connection

One computer connected
with a USB cable to the

rear USB 2.0 High Speed
port on the HP All-in-One.

All features are
supported, except
Webscan.

Follow the Setup Guide
for detailed instructions.

Ethernet (wired)
connection

Up to five computers
connected to an HP All-
in-One using a hub or
router.

All features are
supported, including
Webscan.

Follow the instructions in
“Wired network setup”
on page 37.

Wireless WLAN 802.11
connection

Up to five computers
connected using a
wireless router
(infrastructure mode).

All features are
supported, including
Webscan.

Follow instructions in

“Integrated wireless
WLAN 802.11 network

setup” on page 39.

HP bt450, Printer and PC
Adapter with Bluetooth®
Wireless Technology

One Bluetooth device or
computer.

Printing from a Bluetooth
device such as a PDA or
camera phone, or a
Bluetooth-enabled
computer.

Follow the instructions in
“Connect using the

HP bt450, Printer and PC
Adapter with Bluetooth®
Wireless Technology”

on page 32.

Printer sharing

Five.

The host computer must
be turned on at all times,
or the other computers
will not be able to print to
the HP All-in-One.

All features resident on
the host computer are
supported. Only print is
supported from the other
computers.

Follow the instructions in

“Use printer sharing”
on page 36.

Connect using Ethernet

The HP All-in-One supports both 10 Mbps and 100 Mbps Ethernet network connections.
For detailed instructions on connecting the HP All-in-One to an Ethernet (wired) network,
see “Wired network setup” on page 37.
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Connect using integrated wireless WLAN 802.11

The HP All-in-One uses an internal networking component that supports a wireless
network. For detailed instructions on connecting the HP All-in-One to a wireless (802.11)
network, see “Integrated wireless WLAN 802.11 network setup” on page 39.

Connect using the HP bt450, Printer and PC Adapter with Bluetooth® Wireless
Technology

HP bt450, Printer and PC Adapter with Bluetooth® Wireless Technology allows you to
print images from most Bluetooth devices, including computers. Simply insert the HP
bt450 into the front USB port and print from a Bluetooth device such as a PDA or camera
phone.

This section contains the following topics:

* Find the device name and address
» Set Bluetooth security for the HP All-in-One
* Use a Bluetooth® connection to print from your computer

Find the device name and address

Some Bluetooth devices exchange device addresses when they communicate with each
other, so you might need to find out the device address of the HP All-in-One in order to
establish a connection. Also, some Bluetooth devices display the name of the printer
when connected. If you do not want the default name displayed as the name of the HP All-
in-One, you can change the device name.

To find out the device address of the HP All-in-One

1. Insert the HP bt450 into the front USB port.

2. On the control panel of the HP All-in-One, press Setup.

3. Press ¥ until Bluetooth is highlighted, and then press OK.

4. Press V¥ until Device Address is highlighted, and then press OK.
The Device Address appears, which is read only.

5. To enter the address into your device, follow the instructions that came with your
Bluetooth device.

6. Press OK to exit the Setup menu.

To change the device name of the HP All-in-One

1. On the control panel of the HP All-in-One, press Setup.

2. Press ¥ until Bluetooth is highlighted, and then press OK.

3. Press ¥ until Device Name is highlighted, and then press OK.

BY NOTE: The HP All-in-One ships with the predefined name of Photosmart
C7200.

4. Use the keypad to enter a new name.
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5. When you have finished entering a name for the HP All-in-One, press OK.

The name you entered will appear on your Bluetooth device when you connect to the
HP All-in-One to print.

6. Press OK to exit the Setup menu.

Related topics
“Text and symbols” on page 18

Set Bluetooth security for the HP All-in-One

You can enable printer security settings through the Bluetooth menu on the HP All-in-
One. Press Setup on the control panel, and select Bluetooth. From the Bluetooth menu,
you can:

+ Require passkey authentication prior to someone printing to the HP All-in-One from
a Bluetooth device.

« Make the HP All-in-One visible or invisible to Bluetooth devices that are within range.
This section contains the following topics:

* Use a passkey to authenticate Bluetooth devices

« Set the HP All-in-One to be invisible to Bluetooth devices

* Reset Bluetooth settings on the HP All-in-One

Use a passkey to authenticate Bluetooth devices

You can set the security level of the HP All-in-One to either Low or High. The default
security setting is Low. Low level security does not require authentication.

« Low: This is the default security setting. Low level security does not require a
passkey, as it does not support authentication. Any Bluetooth device within range can
print to it.

« High: High level security requires a passkey, as it supports authentication. The
Bluetooth device must provide a passkey, before the HP All-in-One will allow the
device to send a print job to it.

BY NOTE: The HP All-in-One ships with a predefined passkey that is set to four zeroes
"0000".

To set the HP All-in-One to require passkey authentication
1. On the control panel of the HP All-in-One, press Setup.

2. Press ¥ until Bluetooth is highlighted, and then press OK.
3. Press ¥ until Passkey is highlighted, and then press OK.
4. Use the keypad to enter a new passkey.

Bf NOTE: The passkey must be 1 to 4 characters long, and can only consist of
numbers.

5. When you have finished entering your passkey, press OK.
The Bluetooth menu appears.
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6. Press ¥ until Security Level is highlighted, and then press OK.
7. Press OK to select High.

High level security requires authentication.

Passkey authentication is now set for the HP All-in-One.

Related topics
“Text and symbols” on page 18

Set the HP All-in-One to be invisible to Bluetooth devices

You can set the HP All-in-One to be either Visible to all Bluetooth devices (public) or
Not visible to any (private).
Visible to all: Any Bluetooth device within range can print to the HP All-in-One.

Not visible: Only Bluetooth devices that have stored the device address of the HP All-
in-One can print to it.

B NOTE: The HP All-in-One ships with a default accessibility level of Visible to all.

To set the HP All-in-One to be Not visible

1. On the control panel of the HP All-in-One, press Setup.

2. Press ¥ until Bluetooth is highlighted, and then press OK.
3. Press ¥ until Visibility is highlighted, and then press OK.
4. Press V to select Not visible, and then press OK.

The HP All-in-One is inaccessible to Bluetooth devices that have not stored its device
address.

Reset Bluetooth settings on the HP All-in-One
You can reset all of the Bluetooth settings on the HP All-in-One to the factory defaults.

Bf NOTE: Only select Reset Bluetooth if you want all of the HP All-in-One Bluetooth
settings returned to factory defaults.

To reset the Bluetooth settings

1. On the control panel of the HP All-in-One, press Setup.

2. Press v until Bluetooth is highlighted, then press OK.

3. Press ¥ until Reset Bluetooth is highlighted, then press OK.

Use a Bluetooth® connection to print from your computer

A Bluetooth connection provides a quick and easy way to print images from a Bluetooth-
enabled computer without using a cable. With a Bluetooth connection you can access
many of the same printing features as with a USB connection. For example, you can
check the printer status, as well as the estimated amount of ink remaining in your ink
cartridges.
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BY NOTE: The only software functionality available with a Bluetooth connection is
printing. Scanning and software-based faxing cannot be done over a Bluetooth
connection. However, stand-alone copy and fax functions are still available.

Before you print, you must connect an HP bt450, Printer and PC Adapter with
Bluetooth® Wireless Technology to the HP All-in-One.

You must have Windows XP or Windows Vista and either the Microsoft Bluetooth®
Protocol Stack or the Widcomm Bluetooth® Protocol Stack installed in order to connect
the HP All-in-One. ltis possible to have both the Microsoft Stack and the Widcomm Stack
on your computer, but you use only one of them to connect the HP All-in-One.

*  Microsoft stack If you have Windows XP with Service Pack 2 or Windows Vista
installed on your computer, then your computer has the Microsoft Bluetooth® Protocol
Stack. The Microsoft stack allows you to install an external Bluetooth® adapter
automatically. If your Bluetooth® adapter supports the Microsoft stack but it does not
install automatically, then you do not have the Microsoft stack on your computer.
Check the documentation that came with the Bluetooth® adapter to see if it supports
the Microsoft stack.

* Widcomm stack: If you have an HP computer with Bluetooth® built in, or if you have
installed an HP bt450, then your computer has the Widcomm stack. If you have an
HP computer and plug in an HP bt450, it will install automatically using the Widcomm
stack.

To install and print using the Microsoft stack
1. Make sure that you have installed the HP All-in-One software on the computer.

Bf NOTE: The purpose of installing the software is to make sure the printer driver
is available for the Bluetooth® connection. Therefore, if you have already installed
the software, you do not need to reinstall it. If you want both a USB and a
Bluetooth® connection to the HP All-in-One, install the USB connection first. For
more information, see the Setup Guide. However, if you do not want a USB
connection, select Directly to the computer on the Connection Type screen.
Also, on the Connect Your Device Now screen, select the check box next to If
you are unable to connect your device now... at the bottom of the screen.

2. Attach an HP bt450 to the front USB port of the HP All-in-One.

3. If you are using an external Bluetooth® adapter for your computer, make sure your
computer is started and then attach the Bluetooth® adapter to a USB port on the
computer. If you have Windows XP with Service Pack 2 or Windows Vista installed,
the Bluetooth® drivers are installed automatically. If you are prompted to select a
Bluetooth® profile, select HCRP.

If your computer has Bluetooth® built in, just make sure the computer is started.

4. On the Windows taskbar, click Start, and then click Printers and Faxes (or click

Control Panel, and then Printers).

Double-click the Add Printer icon (or click Add a printer).

Click Next, and then select A Bluetooth Printer.

Follow the onscreen instructions to finish the installation.

Print as you would to any printer.

® NG

Computer connection information 35



Chapter 4

To install and print using the Widcomm stack
1. Make sure that you have installed the HP All-in-One software on the computer.

Bf NOTE: The purpose of installing the software is to make sure the printer driver
is available for the Bluetooth® connection. Therefore, if you have already installed
the software, you do not need to reinstall it. If you want both a USB and a
Bluetooth® connection to the HP All-in-One, install the USB connection first. For
more information, see the Setup Guide. However, if you do not want a USB
connection, select Directly to the computer on the Connection Type screen.
Also, on the Connect Your Device Now screen, select the check box next to If
you are unable to connect your device now... at the bottom of the screen.

Attach an HP bt450 to the front USB port of the HP All-in-One.

Click the My Bluetooth Places icon on the desktop or in the taskbar.

Click View devices in range.

Once the available printers are discovered, double-click the name of HP All-in-One
to finish the installation.

6. Print as you would to any printer.

U

Use printer sharing

If your computer is on a network, and another computer on the network has an HP All-
in-One connected to it by a USB cable, you can print to that printer using printer sharing.
The computer directly connected to the HP All-in-One acts as the host for the printer and
has full software functionality. The other computer, which is referred to as a client, has
access only to the print features. You must perform other functions from the host
computer or from the control panel on the HP All-in-One.

To enable printer sharing on a Windows computer
A Refer to the user guide that came with your computer or see the Windows onscreen
Help.

Connect to a network

This section describes how to connect the HP All-in-One to a network and how to view
and manage network settings.

If you want to:

See this section:

Connect to a wired (Ethernet) network.

“Wired network setup” on page 37

Connect to a wireless network with a wireless
router (infrastructure).

“Integrated wireless WLAN 802.11 network
setup” on page 39

Connect directly to a wireless-capable
computer without a wireless router (ad hoc).

“Wireless ad hoc network setup” on page 43

Install the HP All-in-One software for use in a
networked environment.

“Install the software for a network connection”
on page 46

Add connections to more computers on the
network.

“Connect to additional computers on a
network” on page 47
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(continued)

If you want to: See this section:

Change the HP All-in-One from a USB “Change the HP All-in-One from a USB

connection to a network connection. connection to a network connection”
on page 47

NOTE: Use the instructions in this section if
you first installed the HP All-in-One with a USB
connection, and you now want to change to
either a wireless or Ethernet network

connection.
View or change the network settings. “Manage your network settings” on page 48
Find troubleshooting information. “Network troubleshooting” on page 183

Bf NOTE: You can connect the HP All-in-One to either a wireless or wired network, but
not both at the same time.

Wired network setup

This section describes how to connect the HP All-in-One to a router, switch, or hub using
an Ethernet cable and how to install the HP All-in-One software for a network connection.
This is known as a wired or Ethernet network.

To set up the HP All-in-One on a wired See this section:

network, you need to do the following:

First, collect all of the required materials. “What you need for a wired network”
on page 38

Next, connect to a wired network. “Connect the HP All-in-One to the network”
on page 38

Finally, install the software. “Install the software for a network connection”
on page 46
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What you need for a wired network

Before you connect the HP All-in-One to a network, make sure you have all of the required
materials.

Qa A functional Ethernet network that includes a router, switch, or hub with an Ethernet
port.
Qa CAT-5 Ethernet cable.

= &

Although standard Ethernet cables look similar to standard telephone cables, they
are not interchangeable. There is a different number of wires in each one, and each
has a different connector. An Ethernet cable connector (also called an RJ-45
connector) is wider and thicker and always has 8 contacts on the end. A phone
connector has between 2 and 6 contacts.

1 A desktop computer or laptop with an Ethernet connection.

BY NOTE: The HP All-in-One supports both 10 Mbps and 100 Mbps Ethernet
networks. If you are purchasing, or have purchased, a network interface card
(NIC), make sure it can operate at either speed.

Connect the HP All-in-One to the network
An Ethernet port is provided on the back of the HP All-in-One.

To connect the HP All-in-One to the network
1. Remove the yellow plug from the back of the HP All-in-One.
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2. Connect the Ethernet cable to the Ethernet port on the back of the HP All-in-One.

3. Connect the other end of the Ethernet cable to an available port on your Ethernet
router or switch.

4. Once you have connected the HP All-in-One to the network, install the software.

Related topics
“Install the software for a network connection” on page 46

Integrated wireless WLAN 802.11 network setup
For optimal performance and security in your wireless network, HP recommends you use
a wireless router or access point (802.11) to connect the HP All-in-One and the other
network elements. When network elements are connected through a wireless router or
access point, this is called an infrastructure network.
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The advantages of a wireless infrastructure network as compared to an ad hoc network
include:

» Advanced network security

»  Enhanced reliability

* Network flexibility

« Better performance, especially with 802.11 g mode

+ Shared Broadband Internet access

To set up the HP All-in-One on an integrated | See this section:
wireless WLAN 802.11 network, you need to
do the following:

First, collect all of the required materials. “What you need for an integrated wireless
WLAN 802.11 network” on page 40

Next, connect the HP All-in-One to the wireless | “Connect to an integrated wireless WLAN

router, and run the Wireless Setup Wizard. 802.11 network” on page 40
Finally, install the software. “Install the software for a network connection”
on page 46

What you need for an integrated wireless WLAN 802.11 network

To connect the HP All-in-One to an integrated wireless WLAN 802.11 network, you will
need the following:
A wireless 802.11 network that includes a wireless router or access point.

4 A desktop computer or laptop with either wireless networking support, or a network
interface card (NIC). The computer must be connected to the wireless network that
you intend to install the HP All-in-One on.

1 Broadband Internet access (recommended) such as cable or DSL.

If you connect the HP All-in-One on a wireless network that has Internet access, HP
recommends that you use a wireless router (access point or base station) that uses
Dynamic Host Configuration Protocol (DHCP).

Qa Network name (SSID).
Q WEP key or WPA Passphrase (if needed).

Connect to an integrated wireless WLAN 802.11 network

The Wireless Setup Wizard provides an easy way to connect the HP All-in-One to your
network. You can also use SecureEasySetup, if your wireless router or access point
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supports this feature. See the documentation that came with your wireless router or
access point to find out if it supports using EasySetup and for additional setup instructions.

/\ CAUTION: To prevent other users from accessing your wireless network, HP
strongly recommends using a password or passphrase (WPA or WEP security) and
a unique network name (SSID) for your wireless router. Your wireless router might
have been shipped with a default network name, which is typically the manufacturer
name. If you use the default network name, your network can be easily accessed by
other users using the same default network name (SSID). It also means that the
HP All-in-One might accidently connect to a different wireless network in your area
which uses the same network name. If this happens you will not be able to access
the HP All-in-One. For more information on how to change the network name, see
the documentation that came with your wireless router.

= NOTE: Before connecting to a wireless infrastructure network, ensure that the
ethernet cable is not connected to the HP All-in-One.

To connect the HP All-in-One with the Wireless Setup Wizard

1. Write down the following information about your wireless router or access point:
* Network Name (also called SSID)
« WEP Key, WPA Passphrase (if needed)
If you do not know where to find this information, see the documentation that came
with your wireless router or access point. You might be able to find the network name
(SSID) and the WEP key or WPA passphrase on the Embedded Web Server for the
wireless router or access point.

2. On the control panel of the HP All-in-One, press Setup.

Press ¥ until Network is highlighted, and then press OK.

4. Press ¥ to highlight Wireless Setup Wizard, and then press OK.
This runs the Wireless Setup Wizard. The setup wizard searches for available
networks, and then displays a list of detected network names (SSIDs). The networks
with the strongest signal appear first, the weakest appear last.
The wireless network test also runs, performing a series of diagnostic tests to
determine whether network setup is successful. The wireless network test prints upon
completion of the test.

5. Press ¥ to highlight the name of the network you wrote down in step 1, and then
press OK.

d

If you do not see your network name in the list

a. Select Enter a New Network Name (SSID). If necessary, use the ¥ to highlight
it, and then press OK.
The visual keyboard appears.

b. Enter the SSID. Use the arrow buttons on the HP All-in-One control panel to
highlight a letter or number on the visual keyboard, and then press OK to select
it.

BY NOTE: You mustenter the exact uppercase (capital) and lowercase (small)
letters. Otherwise, the wireless connection will fail.
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c. When you have finished entering the new SSID, use the arrow buttons to highlight
Done on the visual keyboard, and then press OK.

X TIP: If the HP All-in-One is unable to discover the network based on the
network name you entered, you will see the following prompts. You may want
to move the HP All-in-One closer to the computer and try running the Wireless
Setup Wizard again to automatically discover the network.

d. Press ¥ until Infrastructure is highlighted, and then press OK.

e. Press ¥ until WEP encryption or WPA encryption is highlighted, and then press
OK.

If you do not want to use WEP encryption, press ¥ until No, my network does
not use encryption is highlighted, and then press OK. Go to step 7.

6. If prompted, enter your WPA or WEP key as follows:

a. Use the arrow buttons to highlight a letter or number on the visual keyboard, and
then press OK to select it.

Bf NOTE: You mustenter the exact uppercase (capital) and lowercase (small)
letters. Otherwise, the wireless connection will fail.

b. When you are finished entering the WPA or WEP key, use the arrow buttons to
highlight Done on the visual keyboard.

c. Press OK to confirm.
The HP All-in-One will attempt to connect to the network. If a message says you
entered an invalid WPA or WEP key, check the key you wrote down for your new
network, follow the prompts to correct the key, and then try again.

7. When the HP All-in-One connects successfully to the network, install the software on
each computer that will use the device over the network.

To connect the HP All-in-One with SecureEasySetup

Activate SecureEasySetup on your wireless router or access point.

On the control panel of the HP All-in-One, press Setup.

Press ¥ until Network is highlighted, and then press OK.

Press ¥ to highlight Wireless Setup Wizard, and then press OK.
Follow the onscreen prompts on the display to complete the connection.

When the HP All-in-One connects successfully to the network, go to your computer
to install the software on each computer that will use the network.

o9kl wON-=

Br NOTE: If the connection fails, the wireless router or access point might have
timed out after you activated SecureEasySetup. Repeat the above task, ensuring
that you complete the steps on the control panel of the HP All-in-One immediately
after pressing the button on the wireless router or access point.

Related topics

» “Enter text using the visual keyboard” on page 19

+ ‘“Install the software for a network connection” on page 46
+  “Network troubleshooting” on page 183
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Wireless ad hoc network setup

Use this section if you want to connect the HP All-in-One to a wireless-capable computer
without using a wireless router or access point.

Bf NOTE: An ad hoc connection is available if you do not have a wireless router or
access point. However, it provides little flexibility, a low level of network security, and
slower network performance than with a wireless router or access point.

In order to connect the HP All-in-One to your computer (ad hoc), you need to create an
ad hoc network profile on your computer. This includes choosing a network name (SSID)
and WEP security (optional but recommended) for your ad hoc network.

To set up the HP All-in-One on a wireless ad | See this section:
hoc network, you need to do the following:

First, collect all of the required materials. “What you need for an ad hoc network”

on page 43
Next, prepare your computer by creating a “Create a network profile for a Windows XP
network profile. computer” on page 43

“Create a network profile for other operating
systems” on page 45

Next, run the Wireless Setup Wizard. “Connect to a wireless ad hoc network”
on page 45

Finally, install the software. “Install the software for a network connection”
on page 46

What you need for an ad hoc network

To connect the HP All-in-One to a wireless network, you will need a Windows computer
with a wireless network adapter.

Create a network profile for a Windows XP computer
Prepare your computer for an ad hoc connection by creating a network profile.

To create a network profile

BY NOTE: The HP All-in-One comes configured with a network profile with hpsetup as
the network name (SSID). However, for security and privacy HP recommends you
create a new network profile on your computer as described here.
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1. In the Control Panel, double-click Network Connections.

On the Network Connections window, right-click the Wireless Network
Connection. If you see Enable on the pop-up menu, select it. Otherwise, if you see
Disable on the menu, the wireless connection is already enabled.

Right-click the Wireless Network Connection icon, and then click Properties.
Click the Wireless Networks tab.

Select the Use Windows to configure my wireless network settings check box.
Click Add, and then do the following:

a. In Network name (SSID) box, type in a unique network name of your choice.

N

o0, w

B NOTE: The network name is case sensitive, so it is important to remember
any uppercase (capital) and lowercase (small) letters.

b. If there is a Network Authentication list, select Open. Otherwise, go to the next
step.
c. Inthe Data encryption list, select WEP.

EY NOTE: Itis possible to create a network that does not use a WEP key.
However, HP recommends using a WEP key in order to secure your network.

d. Make sure that the check box is not selected next to The key is provided for me
automatically. If it is selected, click the check box to clear it.

e. Inthe Network key box, type a WEP key that has exactly 5 or exactly 13
alphanumeric (ASCII) characters. For example, if you enter 5 characters, you
might enter ABCDE or 12345. Or, if you enter 13 characters, you might enter
ABCDEF1234567. (12345 and ABCDE are examples only. Select a combination
of your choosing.)

Alternatively, you can use HEX (hexadecimal) characters for the WEP key. A HEX
WEP key must be 10 characters for 40 bit encryption, or 26 characters for 128 bit
encryption.

f. In the Confirm network key box, type the same WEP key you typed in the
previous step.

g. Write down the WEP key exactly as you typed it, including uppercase and
lowercase letters.

EY NOTE: You must remember the exact uppercase (capital) and lowercase
(small) letters. If you enter your WEP key incorrectly on the HP All-in-One, the
wireless connection will fail.

h. Select the check box for This is a computer-to-computer (ad hoc) network;
wireless access points are not used.

i. Click OK to close the Wireless network properties window, and then click OK
again.

j. Click OK again to close the Wireless Network Properties Connection window.

Related topics

*  “Network glossary” on page 59
+ “Connect to a wireless ad hoc network” on page 45

Finish setting up the HP All-in-One



Create a network profile for other operating systems

If you have an operating system other than Windows XP, HP recommends that you use
the configuration program that came with your wireless LAN card. To find the
configuration program for your wireless LAN card, access your computer's list of
programs.

Using the LAN card configuration program, create a network profile that has the following
values:

*  Network name (SSID): Mynetwork (example only)

B NOTE: You should create a network name that is unique and easy for you to
remember. Just remember that the network name is case-sensitive. Therefore,
you must remember which letters are uppercase and lowercase.

* Communication mode: Ad Hoc
*  Encryption: enabled

Connect to a wireless ad hoc network

You can use the Wireless Setup Wizard to connect the HP All-in-One to a wireless ad
hoc network.

To connect to a wireless ad hoc network

1. On the control panel of the HP All-in-One, press Setup.

2. Press ¥ until Network is highlighted, and then press OK.

3. Press ¥ to highlight Wireless Setup Wizard, and then press OK.
This runs the Wireless Setup Wizard. The setup wizard searches for available
networks, and then displays a list of detected network names (SSIDs). The
infrastructure networks appear first in the list, followed by available ad hoc networks.
The networks with the strongest signal appear first, the weakest appear last.

4. Onthe display, look for the network name you created on your computer (for example,
Mynetwork).

5. Use the arrow buttons to highlight the network name, and then press OK.
If you found your network name and selected it, go on to step 6.

If you do not see your network name in the list
a. Select Enter a New Network Name (SSID).
The visual keyboard appears.
b. Enter the SSID. Use the arrow buttons on the HP All-in-One control panel to

highlight a letter or number on the visual keyboard, and then press OK to select
it.

BY NOTE: You mustenter the exact uppercase (capital) and lowercase (small)
letters. Otherwise, the wireless connection will fail.
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c. When you have finished entering the new SSID, use the arrow buttons to highlight
Done on the visual keyboard, and then press OK.

X TIP: If the HP All-in-One is unable to discover the network based on the
network name you entered, you will see the following prompts. You may want
to move the HP All-in-One closer to the computer and try running the Wireless
Setup Wizard again to automatically discover the network.

d. Press ¥ until Ad Hoc is highlighted, and then press OK.
e. Press ¥ until Yes, my network uses WEP encryption is highlighted, and then
press OK. The visual keyboard displays.
If you do not want to use WEP encryption, press ¥ until No, my network does
not use encryption is highlighted, and then press OK. Go to step 7.
6. If prompted, enter your WEP key as follows. Otherwise go to step 7.

a. Use the arrow buttons to highlight a letter or number on the visual keyboard, and
then press OK to select it.

Bf NOTE: You mustenter the exact uppercase (capital) and lowercase (small)
letters. Otherwise, the wireless connection will fail.

b. When you are finished entering the WEP key, use the arrow buttons to highlight
Done on the visual keyboard.

7. Press OK again to confirm.

The HP All-in-One will attempt to connect to the SSID. If a message says you entered
an invalid WEP key, check the key you wrote down for your new network, follow the
prompts to correct the WEP key, and then try again.

8. When the HP All-in-One connects successfully to the network, go to your computer
to install the software.

Related topics

* “Enter text using the visual keyboard” on page 19

» “Install the software for a network connection” on page 46
*  “Network troubleshooting” on page 183

Install the software for a network connection

Use this section to install the HP All-in-One software on a computer connected to a
network. Before you install the software, make sure you have connected the HP All-in-
One to a network.

Bf NOTE: If your computer is configured to connect to a series of network drives, make
sure that your computer is currently connected to these drives before installing the
software. Otherwise, HP All-in-One installation software might try to use one of the
reserved drive letters, and you will not be able to access that network drive on your
computer.

NOTE: Installation time can range from 20 to 45 minutes depending on your
operating system, the amount of available space, and the processor speed of your
computer.
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To install the Windows HP All-in-One software

1. Quitall applications running on your computer, including any virus detection software.

2. Insert the Windows CD that came with the HP All-in-One into the CD-ROM drive on
your computer and follow the onscreen instructions.

3. Ifadialog box about firewalls appears, follow the instructions. If you see firewall pop-
up messages, you must always accept or allow the pop-up messages.

4. On the Connection Type screen, select Through the network, and then click
Next.

The Searching screen appears as the Setup program searches for the HP All-in-One
on the network.

5. On the Printer Found screen, verify that the printer description is correct.
If more than one printer is found on the network, the Printers Found screen appears.
Select the HP All-in-One you want to connect.

6. Follow the prompts to install the software.
When you have finished installing the software, the HP All-in-One is ready for use.

7. If you disabled any virus detection software on your computer, make sure to enable
it again.

8. To test your network connection, go to your computer and print a self-test report to
the HP All-in-One.

Connect to additional computers on a network

You can connect the HP All-in-One to more than one computer on a small network of
computers. If the HP All-in-One is already connected to a computer on a network, for
each additional computer you must install the HP All-in-One software. During installation
of a wireless connection, the software will discover the SSID (network name) of the
existing network. Once you have set up the HP All-in-One on the network you will not
need to configure it again when you add additional computers.

sz’ NOTE: You can connectthe HP All-in-One to either a wireless or wired network, but
not both at the same time.

Related topics
“Install the software for a network connection” on page 46

Change the HP All-in-One from a USB connection to a network connection

If you first install the HP All-in-One with a USB connection, you can later change to either
a wireless or Ethernet network connection. If you already understand how to connect to
a network, you can use the general directions below.

BY NOTE: For optimal performance and security in your wireless network, use an
access point (such as a wireless router) to connect the HP All-in-One.

To change a USB connection to an integrated wireless WLAN 802.11 connection
1. Unplug the USB connection from the back of the HP All-in-One.

2. On the control panel of the HP All-in-One, press Setup.

3. Press ¥ until Network is highlighted, and then press OK.
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4. Press V¥ to highlight Wireless Setup Wizard, and then press OK.
This runs the Wireless Setup Wizard.

5. Install the software for a network connection, choose Add a Device, and then choose
Through the network.

6. When the installation is complete, open Printers and Faxes (or Printers) in the
Control Panel and delete the printers for the USB installation.

To change a USB connection to a wired (Ethernet) connection
1. Unplug the USB connection from the back of the HP All-in-One.

2. Connect an Ethernet cable from the Ethernet port on the back of the HP All-in-One
to an available Ethernet port on the router or switch.

3. Install the software for a network connection, choose Add a Device, and then choose
Through the network.

4. When the installation is complete, open Printers and Faxes (or Printers) in the
Control Panel and delete the printers from the previous USB installation.

For more detailed instructions on connecting the HP All-in-One to a network, see:

*  “Wired network setup” on page 37

* ‘“Integrated wireless WLAN 802.11 network setup” on page 39

+  “Wireless ad hoc network setup” on page 43

Manage your network settings

You can manage network settings for the HP All-in-One through the HP All-in-One control
panel. Additional advanced settings are available in the Embedded Web Server, a
configuration and status tool you access from your Web browser using an existing
network connection to the HP All-in-One.

This section contains the following topics:

* Change basic network settings from the control panel

» Change advanced network settings from the control panel settings
* Use the Embedded Web Server

* Network configuration page definitions

Change basic network settings from the control panel

The HP All-in-One control panel enables you to set up and manage a wireless connection
and to perform a variety of network management tasks. This includes viewing the network
settings, restoring the network defaults, turning the wireless radio on and off, and
changing the network settings.

This section contains the following topics:

* Use the Wireless Setup Wizard

* View and print network settings

» Restore network defaults

»  Turn the wireless radio on and off
» Print the wireless network test
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Use the Wireless Setup Wizard

The Wireless Setup Wizard provides an easy way to set up and manage a wireless
connection to the HP All-in-One.

To run the Wireless Setup Wizard

1. On the control panel of the HP All-in-One, press Setup.

2. Press ¥ until Network is highlighted, and then press OK.

3. Press ¥ to highlight Wireless Setup Wizard, and then press OK.
This runs the Wireless Setup Wizard.

Related topics
* ‘“Integrated wireless WLAN 802.11 network setup” on page 39
*  “Wireless ad hoc network setup” on page 43

View and print network settings

You can display a summary of the network settings on the HP All-in-One control panel,
or you can print a more detailed configuration page. The network configuration page lists
all of the important network settings such as the IP address, link speed, DNS, and mDNS.

To view and print the network settings
1. On the control panel of the HP All-in-One, press Setup.
2. Press ¥ until Network is highlighted, and then press OK.
The Network menu appears.
3. Press ¥ until View Network Settings is highlighted, and then press OK.
The View Network Settings menu appears.
4. Do one of the following:
* To display wired network settings, press ¥ until Display Wired Summary is
highlighted, and then press OK.
This displays a summary of the wired (Ethernet) network settings.
* To display wireless network settings, press ¥ until Display Wireless
Summary is highlighted, and then press OK.
This displays a summary of the wireless network settings.
* To print the network configuration page, press ¥ until Print Network
Configuration Page is highlighted, and then press OK.
This prints the network configuration page.

Related topics
“Network configuration page definitions” on page 53

Restore network defaults

You can reset the network settings to what they were when you purchased the HP All-in-
One.

/\ CAUTION: This will erase all wireless setup information that you have entered. In
order to restore this information, you will need to run the Wireless Setup Wizard again.
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To restore network defaults

1. On the control panel of the HP All-in-One, press Setup.

2. Press ¥ until Network is highlighted, and then press OK.

3. Press ¥ until Restore Network Defaults is highlighted, and then press OK.
4. Press OK to confirm that you want to restore the network defaults.

Turn the wireless radio on and off

The wireless radio is off by default. In order to stay connected to a wireless network, the
radio must stay on. When the radio is on, the blue light on the front of the HP All-in-One
is lit. However, if the HP All-in-One is connected to a wired network or you have a USB
connection, the radio is not used. In this case you might want to turn the radio off.

To turn the wireless radio on and off

1. On the control panel of the HP All-in-One, press Setup.

2. Press ¥ until Network is highlighted, and then press OK.

3. Press ¥ until Wireless Radio is highlighted, and then press OK.
4. Press V¥ to highlight On or Off, and then press OK.

Print the wireless network test

The wireless network test performs a series of diagnostic tests to determine whether
network setup is successful. The wireless network test prints automatically when the
Wireless Setup Wizard is run. You also can print the wireless network test at any time.

To print the wireless test report

1. On the control panel of the HP All-in-One, press Setup.

2. Press ¥ until Network is highlighted, and then press OK.

3. Press ¥ until Wireless Network Test is highlighted, and then press OK.
The Wireless Network Test prints.

Related topics
“Network troubleshooting” on page 183

Change advanced network settings from the control panel settings

The advanced network settings are provided for your convenience. However, unless you
are an advanced user, you should not change any of these settings.

This section contains the following topics:

+ Setlink speed
* Change IP settings

Set link speed

You can change the speed at which data is transmitted over the network. The default is
Automatic.
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To set link speed

1. Press Setup.

2. Press ¥ until Network is highlighted, then press OK.
The Network menu appears.

3. Press ¥ until Advanced Setup is highlighted, and then press OK.
Press ¥ until Set Link Speed is highlighted, and then press OK.

4. Press V¥ to select the link speed that matches your network hardware, and then press
OK to confirm the setting.

Automatic
10-Full
10-Half
100-Full
100-Half

Change IP settings

The default setting for the IP settings is Automatic, which sets the IP settings
automatically. However, if you are an advanced user, you might want to manually change
the IP address, subnet mask, or the default gateway. To see the IP address and subnet
mask of the HP All-in-One, print a network configuration page from the HP All-in-One.

B NOTE: When manually entering an IP Setting, you must already be connected to an
active Network, otherwise the setting will not stay when you exit from the menu.

/\ CAUTION: Be careful when manually assigning an IP address. If you enter an invalid
IP address during the installation, your network components will not be able to connect
with the HP All-in-One.

To change IP settings

1. Press Setup.

2. Press ¥ until Network is highlighted, then press OK.
The Network menu appears.

o

Press ¥ until Advanced Setup is highlighted, and then press OK.
Press ¥ until IP Settings is highlighted, and then press OK.

If the HP All-in-One is already connected to a wired network, you are prompted to
confirm that you want to change the IP settings. Press OK.

oo

Press ¥ until Manual is highlighted, and then press OK.
Press ¥ to highlight one of the following IP settings, and then press OK.

IP Address
Subnet Mask
Default Gateway

7. Enter your changes, and then press OK to confirm the setting.

Related topics
«  “View and print network settings” on page 49

*  “Network configuration page definitions” on page 53
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Use the Embedded Web Server

If your computer is connected to an HP All-in-One on a network, you can access the
Embedded Web Server that resides in the HP All-in-One. The Embedded Web Server is
a web-based user interface that provides some options not available on the HP All-in-
One control panel, including Webscan, a feature that lets you scan photos and documents
from the HP All-in-One to your computer using a Web browser, and advanced network
security options. Also, the Embedded Web Server enables you to monitor status and
order printer supplies.

For information on how to use the features available in the Embedded Web Server,
including Webscan, see the onscreen help within the Embedded Web Server. To access
Embedded Web Server help, open the Embedded Web Server, then click the Help link
under Other Links on the Embedded Web Server Home tab.

Bf NOTE: Usethe Embedded Web Server to change network settings not available on
the control panel.

This section contains the following topics:

* Access the Embedded Web Server
Use the Embedded Web Server setup wizard

Access the Embedded Web Server

The computer you use to access the Embedded Web Server on the HP All-in-One must
be connected to the same network as the HP All-in-One.

To access the Embedded Web Server
1. Print a network configuration page to find the IP address for the HP All-in-One.

2. In the Address box in your Web browser on your computer, type the IP address of
the HP All-in-One, as shown on the network settings page. For example, http://
192.168.1.101.

The Embedded Web Server Home page appears, showing information for the HP All-
in-One.

BY NOTE: Ifyou are using a proxy server in your browser, you might need to disable
it to access the Embedded Web Server.

3. If you need to change the language displayed in the Embedded Web Server, do the
following:

a. Click the Settings tab.

b. Click Select Language in the Settings navigation menu.

c. Inthe Select Language list, click the appropriate language.
d. Click Apply.

4. Click the Home tab to access device and network information, or click the
Networking tab to access more network information or to modify network information.

5. Make any configuration changes.
6. Close the Embedded Web Server.

Related topics
“View and print network settings” on page 49
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Use the Embedded Web Server setup wizard

The network setup wizard provided in the Embedded Web Server gives you an intuitive
interface to your network connection parameters.

To access the Embedded Web Server setup wizard

1. Print a network configuration page to find the IP address for the HP All-in-One.

2. In the Address box in your Web browser on your computer, type the IP address of
the HP All-in-One, as shown on the network settings page. For example, http://
192.168.1.101.

The Embedded Web Server Home page appears, showing information for the HP All-
in-One.

B NOTE: Ifyou are using a proxy server in your browser, you might need to disable
it to access the Embedded Web Server.

3. Click the Networking tab.
4. Click Wired (802.3) or Wireless (802.11) in the Connections navigation menu.
5. Click Start Wizard, and then follow all of the wizard instructions.

Related topics
“View and print network settings” on page 49

Network configuration page definitions

The network configuration page shows the network settings for the HP All-in-One. There
are settings for general information, 802.3 wired (Ethernet), 802.11 wireless, and
Bluetooth®.

This section contains the following topics:

* General network settings

*  Wired (802.3) network settings

*  Wireless (802.11) network settings

* Bluetooth settings

Related topics
+  “View and print network settings” on page 49

*  “Network glossary” on page 59
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General network settings

The following table describes the general network settings shown on the network
configuration page.

Parameter Description

Network Status Status of the HP All-in-One:
» Ready: The HP All-in-One is ready to receive or transmit data.
»  Offline: The HP All-in-One is not currently connected to the network.

Active connection | Network mode of the HP All-in-One:

type »  Wired: The HP All-in-One is connected by Ethernet cable to an IEEE
802.3 network.

= Wireless: The HP All-in-One is connected to a wireless (802.11) network.
= None: There is no network connection.

URL The IP address of the Embedded Web Server.

NOTE: You will need to know this URL when you try to access the
Embedded Web Server.

Firmware The internal networking component and device firmware revision code.
Revision

NOTE: If you call HP Support, depending on the problem, you might be
asked to provide the firmware revision code.

Hostname The TCP/IP name assigned by the installation software to the device. By
default, this is the letters HP followed by the last 6 digits of the Media Access
Control (MAC) address.

Admin Password | Status of the administrator's password for the Embedded Web Server:
- Set: Password is specified. You must enter the password to make
changes to the Embedded Web Server parameters.

»  Not Set: No password is set. A password is not required for making
changes to the Embedded Web Server parameters.

mDNS Some local and ad hoc networks do not use central DNS servers. They use
a DNS alternative called mDNS.

With mDNS, your computer can find and use any HP All-in-One connected
to your local area network. It can also work with any other Ethernet-enabled
device that appears on the network.

Wired (802.3) network settings
The following table describes the 802.3 wired settings shown on the network configuration

page.
Parameter Description
Hardware The Media Access Control (MAC) address that identifies the HP All-in-One.

Address (MAC) This is a unique 12-digit identification number assigned to networking
hardware for identification, including routers, switches, and other such
devices. No two pieces of hardware have the same MAC address.
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Parameter Description
NOTE: Some Internet service providers (ISPs) require that you register the
MAC address of the Network Card or LAN Adapter that was connected to
your cable or DSL modem during installation.

IP Address This address uniquely identifies the device on the network. IP addresses are

assigned dynamically through DHCP or AutolP. You can also set up a static
IP address, though this is not recommended.

CAUTION: Be careful when manually assigning an IP address. An invalid
IP address during installation will prevent your network components from
seeing the HP All-in-One.

Subnet Mask

A subnet is an IP address assigned by the installation software to make an
additional network available as part of a larger network. Subnets are specified
by a subnet mask. This mask determines which of the HP All-in-One IP
address bits identify the network and subnet, and which bits identify the device
itself.

NOTE: Itis recommended that the HP All-in-One and the computers that
use it all reside on the same subnet.

Default Gateway

A node on a network that serves as an entrance to another network. A node
in this instance can be a computer or some other device.

NOTE: The address of the default gateway is assigned by the installation
software, unless you have already set a manual ip address.

Configuration
Source

The protocol used to assign the IP address to the HP All-in-One:
»  AutolP: The installation software automatically determines the
configuration parameters.

«  DHCP: The configuration parameters are supplied by a dynamic host
configuration protocol (DHCP) server on the network. On small networks,
this could be a router.

»  Manual: The configuration parameters are set manually, such as a static
IP address.

- Not Specified: The mode used when the HP All-in-One is initializing.

DNS server

The IP address of the domain name service (DNS) for the network. When you
use the web or send an e-mail message, you use a domain name to do it. For
example, the URL http://www.hp.com contains the domain name hp.com. The
DNS on the Internet translates the domain name into an IP address. Devices
use the IP addresses to refer to one another.

« IP Address: The IP address of the domain name server.
- Not Specified: The IP address is not specified, or the device is initializing.

NOTE: Check to see if a DNS IP address appears on the network
configuration page. If no address is shown, obtain the DNS IP address from
your Internet service provider (ISP).

Link
Configuration

The speed at which data is transmitted over a network. Speeds include 10TX-
Full, 10TX-Half, 100TX-Full, and 100TX-Half. When set to None, networking
is disabled.

Total Packets
transmitted

The number of packets transmitted by the HP All-in-One without error since
it has been turned on. The counter clears after the HP All-in-One is turned
off. When a message is transmitted over a packet-switching network, it is
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Parameter

Description

broken up into packets. Each packet contains the destination address as well
as the data.

Total Packets
received

The number of packets received by the HP All-in-One without error since it
has been turned on. The counter clears after the HP All-in-One is turned off.

Wireless (802.11) network settings

The following table describes the 802.11 wireless settings shown on the network
configuration page.

Parameter

Description

Hardware
Address (MAC)

The Media Access Control (MAC) address that identifies the HP All-in-One.
This is a unique 12-digit identification number assigned to networking
hardware for identification, including wireless access points, routers, and
other such devices. No two pieces of hardware have the same MAC address.
Two MAC addresses are assigned: one for wired Ethernet and one for
wireless 802.11.

NOTE: Some Internet service providers (ISPs) require that you register the
MAC address of the Network Card or LAN Adapter that was connected to
your cable or DSL modem during installation.

IP Address

This address uniquely identifies the device on the network. IP addresses are
assigned dynamically through DHCP or AutolP. You can also set up a static
IP address, though this is not recommended.

NOTE: Manually assigning an invalid IP address during installation will
prevent your network components from seeing the HP All-in-One.

Subnet Mask

A subnet is an IP address assigned by the installation software to make an
additional network available as part of a larger network. Subnets are specified
by a subnet mask. This mask determines which of the HP All-in-One IP
address bits identify the network and subnet, and which bits identify the device
itself.

NOTE: Itis recommended that the HP All-in-One and the computers that
use it all reside on the same subnet.

Default Gateway

A node on a network that serves as an entrance to another network. A node
in this instance can be a computer or some other device.

NOTE: The address of the default gateway is assigned by the installation
software.

Configuration
Source

The protocol used to assign the IP address to the HP All-in-One:
= AutolP: The installation software automatically determines the
configuration parameters.

= DHCP: The configuration parameters are supplied by a dynamic host
configuration protocol (DHCP) server on the network. On small networks,
this could be a router.

= Manual: The configuration parameters are set manually, such as a static
IP address.

»  Not Specified: The mode used when the HP All-in-One is initializing.
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Parameter

Description

DNS server

The IP address of the domain name service (DNS) for the network. When you
use the Web or send an e-mail message, you use a domain name to do it.
For example, the URL http://www.hp.com contains the domain name hp.com.
The DNS on the Internet translates the domain name into an IP address.
Devices use the IP addresses to refer to one another.

- IP Address: The IP address of the domain name server.
- Not Specified: The IP address is not specified, or the device is initializing.

NOTE: Check to see if a DNS IP address appears on the network
configuration page. If no address is shown, obtain the DNS IP address from
your Internet service provider (ISP).

Wireless Status

Status of the wireless network:

«  Connected: The HP All-in-One is connected to a wireless LAN and
everything is working.

- Disconnected: The HP All-in-One is not connected to the wireless LAN
due to incorrect settings (such as the wrong WEP key), the HP All-in-One

is out of range, or an Ethernet cable is plugged in and connected to an
active network.

- Disabled: The radio is turned off.
» Not applicable: This parameter does not apply to this network type.

Communication
Mode

An |IEEE 802.11 networking framework in which devices or stations
communicate with each other:

» Infrastructure: The HP All-in-One communicates with other network
devices through a wireless access point, such as a wireless router or
base station.

= Ad hoc: The HP All-in-One communicates directly with each device on
the network. No wireless router or access pointis used. This is also called
a peer-to-peer network.

»  Not applicable: This parameter does not apply to this network type.

Network Name
(SSID)

Service Set Identifier. A unique identifier (up to 32 characters) that
differentiates one wireless local area network (WLAN) from another. The
SSID is also referred to as the network name. This is the name of the network
to which the HP All-in-One is connected.

Signal Strength
(1-5)

The transmitting or return signal graded on a scale of 1 to 5:
» 5: Excellent

» 4: Good

« 3: Fair

. 2:Poor

+ 1: Marginal

= No signal: No signal detected on the network.
»  Not applicable: This parameter does not apply to this network type.

Channel

The channel number currently being used for wireless communication. This
depends on the network in use, and might differ from the requested channel
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Parameter

Description

number. Value is from 1 to 14; countries/regions might limit the range of
approved channels.

»  (number): Value ranging from 1 to 14, depending on country/region.
*  None: No channel is in use.

»  Not Applicable: The WLAN is disabled or this parameter does not apply
to this network type.

NOTE: In ad hoc mode, if you are not able to receive or transmit data
between your computer and the HP All-in-One, make sure that you are using
the same communication channel on your computer and the HP All-in-One.
In infrastructure mode, the channel is dictated by the access point.

Authentication
type

Type of authentication in use:

= None: No authentication in use.

- Open System (ad hoc and infrastructure): No authentication

- Shared Key: WEP key is required.

«  WPA-PSK (infrastructure only): WPA with Pre-Shared Key.

= Not applicable: This parameter does not apply to this network type.

Authentication verifies the identity of a user or device before granting access
to the network, making it more difficult for unauthorized users to access
network resources. This security method is common on wireless networks.

A network using Open System authentication does not screen network users
based on their identities. Any wireless user can have access from the network.
However, such a network might use WEP (Wired Equivalent Privacy)
encryption to provide a first level of security against casual eavesdroppers.

A network using Shared Key authentication provides increased security by
requiring users or devices to identify themselves with a static key (a
hexadecimal or alphanumeric string). Every user or device on the network
shares the same key. WEP encryption is used along with shared key
authentication, using the same key for both authentication and encryption.

A network using server-based (WPA-PSK) authentication provides
significantly stronger security, and is supported in most wireless access
points and wireless routers. The access point or router verifies the identity of
a user or device requesting access to the network before granting that access.
Several different authentication protocols might be used on an authentication
server.

Encryption

The type of encryption in use on the network:

= None: No encryption is in use.

- 64-bit WEP: A 5-character or 10-hex-digit WEP key is in use.

= 128-bit WEP: A 13-character or 26-hex-digit WEP key is in use.

WPA-AES: Advanced Encryption Standard encryption is in use. This is
an encryption algorithm for securing sensitive but unclassified material
by US Government agencies.

«  WPA-TKIP: Temporal Key Integrity Protocol, an advanced encryption
protocol, is in use.

- Automatic: AES or TKIP is in use.

= Not applicable: This parameter does not apply to this network type.
WEP aims to provide security by encrypting data over radio waves so that it

is protected as it is transmitted from one end point to another. This security
method is common on wireless networks.
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Parameter Description

Access Point HW | The hardware address of the wireless router or access point on the network
Address to which the HP All-in-One is connected:

»  (MAC address): The uniqgue MAC (Media Access Control) hardware
address of the access point.

» Not applicable: This parameter does not apply to this network type.

Total Packets The number of packets transmitted by the HP All-in-One without error since
transmitted it has been turned on. The counter clears after the HP All-in-One is turned
off. When a message is transmitted over a packet-switching network; it is
broken up into packets. Each packet contains the destination address as well

as the data.
Total Packets The number of packets received by the HP All-in-One without error since it
received has been turned on. The counter clears after the HP All-in-One is turned off.

Bluetooth settings

The following table describes the Bluetooth settings shown on the network configuration
page.

Parameter Description

Device Address The hardware address of the Bluetooth device.

Device Name The device name assigned to the printer, which can identify it on a Bluetooth
device.

Passkey A value that the user must enter in order to print via Bluetooth.

Visibility Shows whether or not the HP All-in-One is visible to Bluetooth devices that

are within range.

»  Visible to all: Any Bluetooth device within range can print to the HP All-
in-One.

»  Not visible: Only Bluetooth devices that have stored the device address
of the HP All-in-One can print to it.

Security The level of security set for an HP All-in-One connected by Bluetooth.
»  Low: The HP All-in-One does not require a passkey. Any Bluetooth
device within range can print to it.

»  High: The HP All-in-One requires a passkey from the Bluetooth device
before allowing the device to send a print job.

Network glossary

access point A network router that has wireless capability.

ASCII American Standard Code for Information Interchange. The standard for
numbers used by computers to represent all the uppercase and lowercase
Latin letters, numbers, punctuation, etc.

AutolP A feature of the installation software, which determines the configuration
parameters of devices on the network.
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DHCP

Dynamic Host Configuration Protocol. A server on the network that supplies
configuration parameters to devices on the network. On small networks, this
could be a router.

DNS

Domain Name Service. When you use the Web or send an e-mail message,
you use a domain name to do it. For example, the URL http://www.hp.com

contains the domain name hp.com. The DNS on the Internet translates the
domain name into an IP address. Devices use the IP addresses to refer to

one another.

DNS-SD

See DNS. The SD portion stands for Service Discovery. This is part of a
protocol developed by Apple that enables automatic discovery of computers,
devices, and services on IP networks.

DSL

Digital Subscriber Line. A high-speed connection to the Internet.

Ethernet

The most common local network technology that connects computers using
copper cabling.

Ethernet cable

The cable used to connect network elements in a wired network. The CAT-5
Ethernet cable is also known as a straight-through cable. When using an
Ethernet cable, the network elements must be attached to a router. An
Ethernet cable uses an RJ-45 connector.

EWS Embedded Web Server. A browser-based utility that provides a simple way
to manage the HP All-in-One. You can monitor status, configure HP All-in-
One networking parameters, or access HP All-in-One features.

Gateway A computer or other device, such as a router, that serves as an entrance to
the Internet or another network.

HEX Hexadecimal. The base 16 numbering system, which uses the digits 0-9 plus

the letters A-F.

host computer

The computer at the center of a network.

Hostname

The TCP/IP name assigned by the installation software to the device. By
default, this is the letters HP followed by the last 6 digits of the Media Access
Control (MAC) address.

hub

No longer commonly used in modern home networks, a hub takes its signal
from each computer and sends it to all of the other computers connected to
the hub. Hubs are passive; other devices on the network plug into the hub in
order to communicate with one another. A hub does not manage the network.

IP address

A number that uniquely identifies the device on the network. IP addresses
are assigned dynamically through DHCP or AutolP. You can also set up a
static IP address, though this is not recommended.

MAC address

Media Access Control (MAC) address that uniquely identifies the HP All-in-
One. This is a unique 12-digit identification number assigned to networking
hardware for identification. No two pieces of hardware have the same MAC
address.

network name

The SSID or network name identifies a wireless network.

NIC

Network Interface Card. A card on your computer that provides an Ethernet
connection so that you can connect your computer to a network.

RJ-45 connector

The connector on the ends of an Ethernet cable. Although standard Ethernet
cable connectors (RJ-45 connectors) look similar to standard telephone
cable connectors, they are not interchangeable. An RJ-45 connector is wider
and thicker and always has 8 contacts on the end. A phone connector has
between 2 and 6 contacts.
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router A router provides a bridge between two or more networks. A router can link
a network to the Internet, link two networks and connect both to the Internet,
and help secure networks through the use of firewalls and assigning dynamic
addresses. A router can also act as a gateway, while a switch cannot.

SSID The SSID or network name identifies a wireless network.

switch A switch makes it possible for several users to send information over a
network at the same time without slowing each other down. Switches allow
different nodes (a network connection point, typically a computer) of a
network to communicate directly with one another.

WEP Wired Equivalent Privacy (WEP) is a type of encryption used for wireless
network security.

WPA Wi-Fi Protected Access (WPA) is a type of encryption used for wireless
network security. WPA offers greater security than WEP.

Fax setup

After completing all the steps in the Setup Guide, use the instructions in this section to
complete your fax setup. Please keep your Setup Guide for later use.

In this section, you will learn how to set up the HP All-in-One so that faxing works
successfully with equipment and services you might already have on the same phone
line as the HP All-in-One.

Br NOTE: Refer to your printed documentation for complete step-by-step instructions
on setting up and configuring the HP All-in-One for faxing with other telephone or
office equipment and services.

For fax setup information in specific countries/regions, you can also see the Fax
Configuration Web site listed below.

Austria

www.hp.com/at/faxconfig

Germany

www.hp.com/de/faxconfig

Switzerland (French)

www.hp.com/ch/fr/faxconfig

Switzerland (German)

www.hp.com/ch/de/faxconfig

United Kingdom

www.hp.com/uk/faxconfig

Spain

www.hp.es/faxconfig

The Netherlands

www.hp.nl/faxconfig

Belgium (France)

www.hp.be/fr/faxconfig

Belgium (Dutch)

www.hp.be/nl/faxconfig

Portugal www.hp.pt/faxconfig
Sweden www.hp.se/faxconfig
Finland www.hp.fi/faxconfig

Denmark www.hp.dk/faxconfig
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(continued)

Norway www.hp.no/faxconfig

Ireland www.hp.com/ie/faxconfig
France www.hp.com/fr/faxconfig
Italy www.hp.com/it/faxconfig

This section contains the following topics:

* Change settings on the HP All-in-One to receive faxes
» Test your fax setup

» Set the fax header

» Set up speed dialing

Related topics
“Use the fax features” on page 131

Change settings on the HP All-in-One to receive faxes

In order to receive faxes successfully, you might need to change some settings on the
HP All-in-One. If you are unsure which setting to choose for a specific fax option, refer to
the detailed fax setup instructions provided in the printed documentation.

This section contains the following topics:

+ Set the answer mode
« Set the number of rings before answering
* Change the answer ring pattern for distinctive ringing

Set the answer mode

The answer mode determines whether the HP All-in-One answers incoming calls or not.

» Turn on the Auto Answer setting if you want the HP All-in-One to answer faxes
automatically. The HP All-in-One will answer all incoming calls and faxes.

«  Turn off the Auto Answer setting if you want to receive faxes manually. You must
be available to respond in person to the incoming fax call or the HP All-in-One will not
receive faxes.

To set the answer mode
A Press Auto Answer to turn the light on or off, as appropriate for your setup.

When the Auto Answer light is on, the HP All-in-One answers calls automatically.
When the light is off, the HP All-in-One does not answer calls.

Set the number of rings before answering

If you turn on the Auto Answer setting, you can specify how many rings should occur
before the HP All-in-One automatically answers the incoming call.

The Rings to Answer setting is important if you have an answering machine on the same
phone line as the HP All-in-One, because you want the answering machine to answer

the phone before the HP All-in-One does. The number of rings to answer for the HP All-
in-One should be greater than the number of rings to answer for the answering machine.
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For example, set your answering machine to a low number of rings and the HP All-in-One
to answer in the maximum number of rings. (The maximum number of rings varies by
country/region.) In this setup, the answering machine will answer the call and the HP All-
in-One will monitor the line. If the HP All-in-One detects fax tones, the HP All-in-One will
receive the fax. If the call is a voice call, the answering machine will record the incoming
message.

To set the number of rings before answering from the control panel
1. Press Setup.

2. Press ¥ to highlight Basic Fax Setup and press OK.

3. Press ¥ to highlight Rings to Answer and then press OK.

4

Enter the appropriate number of rings by using the keypad, or press ¥ or A to change
the number of rings.

5. Press OK to accept the setting.

Change the answer ring pattern for distinctive ringing

Many phone companies offer a distinctive ringing feature that allows you to have several
phone numbers on one phone line. When you subscribe to this service, each number will
have a different ring pattern. You can set up the HP All-in-One to answer incoming calls
that have a specific ring pattern.

If you connect the HP All-in-One to a line with distinctive ringing, have your telephone
company assign one ring pattern to voice calls and another ring pattern to fax calls. HP
recommends that you request double or triple rings for a fax number. When the HP All-
in-One detects the specified ring pattern, it will answer the call and receive the fax.

If you do not have a distinctive ring service, use the default ring pattern, which is All
Rings.

To change the distinctive ring pattern from the control panel

1. Verify that the HP All-in-One is set to answer fax calls automatically.
Press Setup.

Press ¥ to highlight Distinctive Ring, and then press OK.

Press ¥ to highlight Advanced Fax Setup, and then press OK.
Press ¥ to highlight the appropriate option, and then press OK.

When the phone rings with the ring pattern assigned to your fax line, the HP All-in-
One answers the call and receives the fax.

akrobd

Test your fax setup

You can test your fax setup to check the status of the HP All-in-One and to make sure it
is set up properly for faxing. Perform this test after you have completed setting up the
HP All-in-One for faxing. The test does the following:

* Tests the fax hardware

« Verifies the correct type of phone cord is connected to the HP All-in-One

«  Checks that the phone cord is plugged into the correct port

«  Checks for a dial tone
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Checks for an active phone line
Tests the status of your phone line connection

The HP All-in-One prints a report with the results of the test. If the test fails, review the
report for information on how to fix the problem and rerun the test.

To test your fax setup from the control panel

1.

Set up the HP All-in-One for faxing according to your particular home or office setup
instructions.

Insert the ink cartridges and load full-size paper in the input tray before starting the
test.

Press Setup.

Press ¥ to highlight Tools, and then press OK.

Press V¥ to highlight Run Fax Test, and then press OK.

The HP All-in-One displays the status of the test on the display and prints a report.
Review the report.

+ If the test passes and you are still having problems faxing, check the fax settings
listed in the report to verify the settings are correct. A blank or incorrect fax setting
can cause problems faxing.

+ If the test fails, review the report for more information on how to fix any problems
found.

After you pick up the fax report from the HP All-in-One, press OK.

If necessary, resolve any problems found and rerun the test.

Set the fax header

The fax header prints your name and fax number on the top of every fax you send. HP
recommends that you set up the fax header by using the software that you installed with
the HP All-in-One. You can also set up the fax header from the control panel, as described
here.

64

Bf NOTE: Insome countries/regions the fax header information is a legal requirement.

To set a default fax header from the control panel

1. Press Setup.

2. Press ¥ to highlight Basic Fax Setup and press OK.

3. Press V¥ to highlight Fax Header, and then press OK.
The visual keyboard appears on the display.

4. Use the visual keyboard to enter your personal or company name. When you are
finished, highlight Done on the visual keyboard, and then press OK.

5. Enter your fax number by using the numeric keypad, and then press OK.

Related topics

“Enter text using the visual keyboard” on page 19
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Set up speed dialing
You can assign speed dial entries to fax numbers you use often. This lets you dial those
numbers quickly by using the control panel.
This section contains the following topics:
» Set up individual speed dial entries
» Set up group speed dial entries
» Delete speed dial entries
¢ Print the speed dial list

Set up individual speed dial entries

You can create speed dial entries for fax numbers that you use frequently. If necessary,
you can also edit the name or fax number of a speed dial entry you have already created.

Q TIP: You can include individual speed dial entries in a group speed dial entry. This
enables you to send a fax to a group of people at one time. (The maximum number
of individual speed dial entries allowed in a group speed dial entry varies by model.)

This section contains the following topics:

e Create individual speed dial entries
* Update individual speed dial entries

Create individual speed dial entries

You can create speed dial entries from the control panel or from your computer by using
the software that you installed with the HP All-in-One.

To create speed dial entries from the control panel

1. Press Setup.

2. Press ¥ to highlight Speed Dial Setup, and then press OK.

3. Press ¥ to highlight Individual Speed Dial, and then press OK.
The first unassigned speed dial entry appears on the display.

4. Press OK to select the displayed speed dial entry. You can also press ¥ to highlight
a different unassigned entry, and then press OK.

5. Enter the fax number for the speed dial entry by using the numeric keypad, and then
press OK.

X TIP: To add a pause in the fax number you are entering, press the Symbols
(*) button repeatedly until a dash (-) appears on the display.

The visual keyboard appears on the display.

6. Use the visual keyboard to enter the name. When you are finished, highlight Done
on the visual keyboard, and then press OK.

7. Press OK if you want to set up another number.

Related topics
“Enter text using the visual keyboard” on page 19
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Update individual speed dial entries

You can edit the name or fax number in a speed dial entry from the control panel or from
your computer by using the software that you installed with the HP All-in-One.

To update a speed dial entry from the control panel

1. Press Setup.

2. Press V¥ to highlight Speed Dial Setup, and then press OK.

3. Press ¥ to highlight Individual Speed Dial, and then press OK.
The first unassigned speed dial entry appears on the display.

4. Press V¥ or A to scroll through the speed dial entries, and then press OK to select
the appropriate entry.

5. When the current fax number appears, press € to erase it.
6. Enter the new fax number by using the numeric keypad, and then press OK.

{r TIP: To add a pause in the fax number you are entering, press the Symbols
(*) button repeatedly until a dash (-) appears on the display.

The visual keyboard appears on the display.

7. Use the visual keyboard to enter a new name. When you are finished, highlight
Done on the visual keyboard, and then press OK.

8. Press OK if you want to update another number.

Related topics

“Text and symbols” on page 18
* “Enter text using the visual keyboard” on page 19

Set up group speed dial entries

You can place individual speed dial entries that you have set up into groups, so that you
can fax the same document to multiple recipients at once. (The maximum number of
individual speed dial entries allowed in a group speed dial entry varies by model.)

Bf NOTE: The numbers you include in the group speed dial entry must already be set
up as individual speed dial entries on the HP All-in-One.

Q TIP: You can send a one time only fax to multiple recipients by using the Broadcast
Fax feature. The Broadcast Fax recipient list is not saved and only works for sending
faxes in black.

To create group speed dial entries from the control panel

1. Press Setup.

2. Press ¥ to highlight Speed Dial Setup, and then press OK.

3. Press ¥ to highlight Group Speed Dial, and then press OK.
The first unassigned speed dial entry appears on the display.

Press OK to select the displayed speed dial entry. You can also press V¥ to highlight
a different unassigned entry, and then press OK.

P
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5. Press ¥ or A to scroll through the individual speed dial entries you set up, and then
press OK to select the appropriate entry. Repeat this step for each number you want
to add to the group speed dial.

6. When you are done, press A to highlight Done Selecting, and then press OK.
The visual keyboard appears on the display.

7. Use the visual keyboard to enter a name for the group speed dial. When you are
finished, highlight Done on the visual keyboard, and then press OK.

8. Press OK to add another group.

Related topics
«  “Enter text using the visual keyboard” on page 19
» “Broadcast a fax to multiple recipients” on page 136

Delete speed dial entries

You can delete an individual or group speed dial entry. When deleting speed dial entries,
consider the following:

« Deleting an individual speed dial entry also deletes that entry from any groups to
which you have assigned it.

« Deleting a group speed dial entry does not delete the individual speed dial entries
associated with it. You can still use the individual speed dial entries to send faxes.

To delete speed dial entries from the control panel

1. Press Setup.

2. Press ¥ to highlight Speed Dial Setup, and then press OK.
3. Press ¥ to highlight Delete Speed Dial, and then press OK.
4

Press ¥ to highlight the speed dial entry that you want to delete, and then press
OK.

Print the speed dial list

You can print a list of all the speed dial entries that you programmed on the HP All-in-
One.

To print the speed dial list

1. Press Setup.

2. Press ¥ to highlight Speed Dial Setup, and then press OK.

3. Press V¥ to highlight Print Speed Dial List, and then press OK.

{} TIP: You can also print this list by selecting Speed Dial List from the Print
Report menu.
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How do I?

This section contains links to commonly performed tasks, such as printing photos,
scanning, making copies, and faxing.

“How do | print 10 x 15 cm (4 x 6) inch borderless photos from a memory card?”
on page 104

“How do | make reprints of a photo in a variety of sizes?” on page 115
“How do | make a black-and-white or color copy of a document?” on page 121

“How do | print 13 x 18 cm (5 x 7) inch or larger size photos from a memory card?”
on page 104

“How do | save photos to my computer?” on page 108

“How do | share my photos with family and friends?” on page 107
“How do | scan a photo or document to the computer?” on page 117
“How do | print on both sides of the paper?” on page 93

“How do | print wide-rule notebook paper and graph paper for my child's homework
project?” on page 153

“How do | test my fax setup?” on page 63

“How do | send a basic fax?” on page 131

“How do | manually send a fax?” on page 133

“How do | use a credit card when sending a fax?” on page 134
“How do | broadcast a fax to multiple recipients?” on page 136
“How do | manually receive a fax?” on page 140

“How do | print a fax confirmation report?” on page 150

How do 1?
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6 Load originals and load paper

You can load many different types and sizes of paper in the HP All-in-One, including letter
or A4 paper, legal paper, photo paper, transparencies, envelopes, and HP CD/DVD tattoo
labels. By default, the HP All-in-One is set to detect the size and type of paper you load
in the input tray automatically and then adjust its settings to generate the highest quality
output for that paper.

If you are using special papers, such as photo paper, transparency film, envelopes, or
labels, or if you experience poor print quality using the automatically-adjusted settings,
you can manually set the paper size and type for print and copy jobs.

This section contains the following topics:

* Load originals

* Choose papers for printing and copying
* Load paper

* Avoid paper jams

Load originals

You can load an original for a copy, fax, or scan job in the automatic document feeder or
on the glass. Originals that are loaded in the automatic document feeder will automatically
be fed into the HP All-in-One.

This section contains the following topics:

* Load an original in the automatic document feeder
¢ Load an original on the glass

Load an original in the automatic document feeder

You can copy, scan, or fax a single- or multiple-page letter-, A4-, or legal-size document
by placing it in the document feeder tray.

The automatic document feeder holds up to 50 sheets of letter or A4 paper, or 35 sheets
of legal paper.
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Br NOTE: Some features, such as the Fit to Page copy feature, do not work when you
load your originals in the automatic document feeder. You must load your originals
on the glass.

/\ CAUTION: Do not load photos in the automatic document feeder; this might cause
damage to your photos.
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To load an original in the document feeder tray

1. Load your original, with the print side up, into the document feeder tray. Slide the
paper into the automatic document feeder until you hear a beep or see a message
on the display indicating that the HP All-in-One detected the pages you loaded.
If you are loading legal paper, flip open the feeder tray extender before loading the
paper.

{r TIP: For more help on loading originals in the automatic document feeder, refer
to the diagram engraved in the document feeder tray.

2. Slide the paper guides inward until they stop at the left and right edges of the paper.

B NOTE: Remove all originals from the document feeder tray before lifting the lid on
the HP All-in-One.

Load an original on the glass

You can copy, scan, or fax up to letter- or A4-size originals by loading them on the glass.
If your original is legal-size or contains multiple full-size pages, load it in the automatic
document feeder.

Bf NOTE: Many of the special features will not work correctly if the glass and lid backing
are not clean.

To load an original on the glass

1. Remove all originals from the document feeder tray, and then lift the lid on the HP All-
in-One.

2. Load your original print side down on the right front corner of the glass.
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{r TIP: For more help on loading an original, refer to the engraved guides along the
edge of the glass.
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3. Close the lid.

Choose papers for printing and copying

You can use different types and sizes of paper in the HP All-in-One. Review the following
recommendations to get the best printing and copying quality. Whenever you change
paper types or sizes, remember to change those settings.

This section contains the following topics:

< Recommended papers for printing and copying
« Recommended papers for printing only
» Papers to avoid

Recommended papers for printing and copying

If you want the best print quality, HP recommends using HP papers that are specifically
designed for the type of project you are printing. If you are printing photos, for example,
load HP Premium or HP Premium Plus photo paper in the input tray.

HP Premium Plus Photo Paper

HP Premium Plus Photo Papers are the best HP photo paper, with image quality and
fade resistance superior to store-processed photos. They are ideal for printing your high-
resolution images for framing or including in a photo album. These papers are available
in several sizes, including 10 x 15 cm (4 x 6 inch) (with or without tabs), A4, and 8.5 x 11
inch sizes for printing or copying photos from the HP All-in-One.

HP Premium Photo Paper

HP Premium Photo Papers are high-quality, glossy-finish or soft gloss-finish photo
papers. They look and feel like store-processed photos and can be mounted under glass
or in an album. These papers are available in several sizes, including 10 x 15 ¢cm (4 x 6
inch) (with or without tabs), A4, and 8.5 x 11 inch sizes for printing or copying photos from
the HP All-in-One.
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HP Advanced Photo Paper or HP Photo Paper

HP Advanced Photo Paper or HP Photo Paper is a sturdy, glossy photo paper that
features an instant-dry finish for easy handling without smudging. It resists water, smears,
fingerprints, and humidity. Your prints have a look and feel comparable to a store-
processed photo. It is available in several sizes, including A4, 8.5 x 11 inch, and 10 x 15
cm (4 x 6 inch) (with or without tabs) for printing or copying photos from the HP All-in-
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One. HP Advanced Photo Paper is marked on the nonprinting corners with the following
symbol.

Il 2

HP Premium Inkjet Transparency Film and HP Premium Plus Inkjet Transparency
Film

HP Premium Inkjet Transparency Film and HP Premium Plus Inkjet Transparency Film
make your color presentations vivid and even more impressive. This film is easy to use
and handle and dries quickly without smudging.

HP Premium Inkjet Paper

HP Premium Inkjet Paper is the ultimate coated paper for high-resolution usage. A
smooth, matte finish makes it ideal for your highest-quality documents.

HP Bright White Inkjet Paper

HP Bright White Inkjet Paper delivers high-contrast colors and sharp text. It is opaque
enough for two-sided color usage with no show-through, which makes it ideal for
newsletters, reports, and flyers.

HP All-in-One Paper or HP Printing Paper

+ HP All-in-One Paper is specifically designed for HP All-in-One devices. It has an extra
bright blue-white shade that produces sharper text and richer colors than ordinary
multifunction papers.
HP Printing Paper is a high-quality multifunction paper. It produces documents that
look and feel more substantial than documents printed on standard multipurpose or
copy paper.

To order genuine HP supplies for the HP All-in-One, go to www.hp.com/buy/supplies. If
prompted, choose your country/region, follow the prompts to select your product, and
then click one of the shopping links on the page.

Recommended papers for printing only

Certain papers are supported only when you start the print job from your computer. The
following list provides information about these papers.

If you want the best print quality, HP recommends using HP papers. Using paper that is
too thin or too thick, paper that has a slick texture, or paper that stretches easily can cause
paper jams. Using paper that has a heavy texture or does not accept ink can cause printed
images to smear, bleed, or not fill in completely.

Depending on your country/region, some of these papers might not be available.

HP Iron-On Transfers

HP Iron-On Transfers (for color fabrics or for light or white fabrics) are the ideal solution
for creating custom T-shirts from your digital photos.
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HP Premium Photo Cards
HP Premium Photo Cards enable you to make your own greeting cards.

HP Brochure & Flyer Paper

HP Brochure & Flyer Paper (Gloss or Matte) is glossy-coated or matte-coated on both
sides for two-sided use. They are the perfect choice for near-photographic reproductions
and business graphics for report covers, special presentations, brochures, mailers, and
calendars.

HP Premium Presentation Paper
HP Premium Presentation Paper gives your presentation a quality look and feel.

HP CD/DVD Tattoos

HP CD/DVD Tattoos allow you to personalize your CDs and DVDs by printing high-
quality, low-cost CD or DVD labels.

To order genuine HP supplies for the HP All-in-One, go to www.hp.com/buy/supplies. If
prompted, choose your country/region, follow the prompts to select your product, and
then click one of the shopping links on the page.

Papers to avoid

Using paper that is too thin or too thick, paper that has a slick texture, or paper that
stretches easily can cause paper jams. Using paper that has a heavy texture or does not
accept ink can cause printed images to smear, bleed, or not fill in completely.

Papers to avoid for all print and copy jobs
* Any size paper other than those listed in the HP All-in-One printer software.

« Paper with cutouts or perforations (unless specifically designed for use with HP inkjet
devices).

« Highly textured stock, such as linen. It might not print evenly, and the ink can bleed
into these papers.

«  Extremely smooth, shiny, or coated papers not specifically designed for the HP All-
in-One. They can jam the HP All-in-One or repel the ink.

« Multi-part forms, such as duplicate and triplicate forms. They can wrinkle or get stuck,
and the ink is more likely to smear.

+  Envelopes with clasps or windows. They can get stuck in the rollers and cause paper
jams.

« Banner paper.
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Additional papers to avoid when copying
*  Envelopes.

« Transparency film other than HP Premium Inkjet Transparency Film or HP Premium
Plus Inkjet Transparency Film.

* Iron-On Transfers.
»  Greeting card paper.
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* Inkjet labels.
+  HP CD/DVD tattoo labels.

Load paper

This section describes the procedure for loading different types and sizes of paper into
the HP All-in-One for your copies or printouts.

ﬂ} TIP: To help prevent rips, wrinkles, and curled or bent edges, store all paper flat in
aresealable bag. If the paper is not stored properly, extreme changes in temperature
and humidity might result in curled paper that does not work well in the HP All-in-One.

This section contains the following topics:

* Load full-size paper
* Load 10 x 15 cm (4 x 6 inch) photo paper
* Load postcards, Hagaki, or index cards

* Load envelopes
* Load other types of paper

Load full-size paper

You can load many types of letter, A4, or legal paper into the main input tray of the HP All-
in-One.

To load full-size paper

1. Pull out the main input tray, and then slide the paper-width and paper-length guides
to their outermost positions.
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2. Tap a stack of paper on a flat surface to align the edges, and then check the paper
for the following:

+ Make sure it is free of rips, dust, wrinkles, and curled or bent edges.
+ Make sure all the paper in the stack is the same size and type.
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3.

Insert the stack of paper into the main input tray with the short edge forward and the
print side down. Slide the stack of paper forward until it stops.

/\ CAUTION: Make sure that the HP All-in-One is idle and silent when you load
paper into the main input tray. If the HP All-in-One is servicing the ink cartridges
or otherwise engaged in a task, the paper stop inside the device might not be in
place. You could push the paper too far forward, causing the HP All-in-One to
eject blank pages.

3¢ TIP: If you are using letterhead, insert the top of the page first with the print side
down. For more help on loading full-size paper and letterhead, refer to the diagram
engraved in the base of the main input tray.

Slide the paper-width and paper-length guides inward until they stop at the edges of
the paper.

Do not overload the main input tray; make sure the stack of paper fits within the main
input tray and is no higher than the top of the paper-width guide.
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5. Push the main input tray back into the HP All-in-One.
6. Pull the output tray extender toward you, as far as it will go.

Br NOTE: When you use legal-size paper, leave the tray extender closed.

Related topics
+ “Recommended papers for printing and copying” on page 73
+ “Change the print settings for the current job” on page 84

Load 10 x 15 cm (4 x 6 inch) photo paper

You can load up to 10 x 15 cm (4 x 6 inch) photo paper into the photo tray of the HP All-
in-One. For the best results, use 10 x 15 cm (4 x 6 inch) HP Premium Plus Photo
Paper or HP Premium Photo Paper.

To load 10 x 15 cm (4 x 6 inch) photo paper in the photo tray
1. Raise the output tray, and then pull out the photo tray.
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2. Insert the stack of photo paper into the photo tray with the short edge forward and the
glossy side down. Slide the stack of photo paper forward until it stops.
If the photo paper you are using has perforated tabs, load the photo paper so that the
tabs are closest to you.
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3. Slide the paper-length and paper-width guides inward against the stack of photo
paper until the guides stop.
Do not overload the photo tray; make sure the stack of photo paper fits within the
photo tray and is no higher than the top of the paper-width guide.

4. Push in the photo tray, and then lower the output tray.

Related topics

*  “Recommended papers for printing only” on page 74
»  “Print your photos” on page 104

«  “Print a borderless image” on page 90

* “Print a photo on photo paper” on page 91

Load postcards, Hagaki, or index cards
You can load postcards, Hagaki, and index cards in the photo tray.
For best results, set the paper type and paper size before copying or printing.

To load postcards, Hagaki or index cards in the photo tray
1. Raise the output tray, and then pull out the photo tray.
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2. Insert the stack of cards into the photo tray with the short edge forward and the print
side down. Slide the stack forward until it stops.
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3. Slide the paper-length and paper-width guides inward against the stack of cards until
the guides stop.
Do not overload the photo tray; make sure the stack of cards fits within the photo tray
and is no higher than the top of the paper-width guide.

4. Push in the photo tray, and then lower the output tray.

Related topics
“Change the print settings for the current job” on page 84

Load envelopes

You can load one or more envelopes into the main input tray of the HP All-in-One. Do not
use shiny or embossed envelopes or envelopes that have clasps or windows.

EY NOTE: For specific details on how to format text for printing on envelopes, consult
the help files in your word processing software. For best results, consider using a label
for the return address on envelopes.

To load envelopes
1. Pull out the main input tray to load envelopes.
2. Remove all paper from the main input tray.

3. Insert one or more envelopes into the far-right side of the main input tray, with the
envelope flaps on the left and facing up. Slide the stack of envelopes forward until it
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4. Slide the paper-width guide inward against the stack of envelopes until it stops.
Do not overload the main input tray; make sure the stack of envelopes fits within the
main input tray and is not higher than the top of the paper-width guide.

5. Push the main input tray back into the HP All-in-One.
6. Pull the output tray extender towards you, as far as it will go.

Related topics
“Change the print settings for the current job” on page 84

Load other types of paper

The following types of paper are designed for special projects. Create your project in the
HP Photosmart Software or another application, set the paper type and size, and then
print.

HP Premium Inkjet Transparency Film and HP Premium Plus Inkjet Transparency

Film

A Insert the film so that the white transparency strip (with arrows and the HP logo) is on
top and is going into the input tray first.

EY NOTE: For best results, set the paper type to transparency film before printing
on transparency film.

HP Iron-On Transfers
1. Flatten the transfer sheet completely before using it; do not load curled sheets.

{} TIP: To prevent curling, keep transfer sheets sealed in the original package until
you are ready to use them.

2. Locate the blue stripe on the nonprinting side of the transfer paper and then manually
feed one sheet at a time into the input tray with the blue stripe facing up.

HP Greeting Cards, HP Photo Greeting Cards, or HP Textured Greeting Cards

A Insert a small stack of HP greeting card paper into the input tray with the print side
down; slide the stack of cards forward until it stops.

{} TIP: Make sure the area on which you want to print is inserted first, print side
down in the input tray.
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Inkjet labels

1. Always use letter or A4 label sheets designed for use with inkjet devices, and make
sure that the labels are no more than two years old. Labels on older sheets might
peel off when the paper is pulled through the HP All-in-One, causing subsequent
paper jams.

2. Fan the stack of labels to make sure none of the pages are sticking together.

3. Place a stack of label sheets on top of full-size plain paper in the input tray, label side
down. Do not insert labels one sheet at a time.

For best results, set the paper type and paper size before printing.
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HP CD/DVD Tattoo labels

A Place one sheet of CD/DVD tattoo paper in the input tray with the print side down;
slide the CD/DVD tattoo paper forward until it stops.

BY NOTE: When you use CD/DVD tattoo labels, leave the tray extender closed.

Related topics
* “Change the print settings for the current job” on page 84
“Recommended papers for printing only” on page 74

Avoid paper jams
To help avoid paper jams, follow these guidelines.

+Remove printed papers from the output tray frequently.

« Do not leave originals on the glass. If you load an original in the automatic document
feeder while there is already an original on the glass, the original can jam in the
automatic document feeder.

« Prevent curled or wrinkled paper by storing all unused paper flat in a resealable bag.

« Ensure that paper loaded in the input tray lays flat and the edges are not bent or torn.

+ If you are printing labels, ensure that the label sheets are no more than two years old.
Labels on older sheets might peel off when the paper is pulled through the HP All-in-
One, and cause paper jams.

- Do not combine different paper types and paper sizes in the input tray; the entire stack
of paper in the input tray must be the same size and type.

+ Adjust the paper-width guide in the input tray to fit snugly against all paper. Make sure
the paper-width guide does not bend the paper in the input tray.

+ Do not force paper too far forward in the input tray.
» Use paper types that are recommended for the HP All-in-One.

Related topics
“Recommended papers for printing and copying” on page 73
“Papers to avoid” on page 75

* “Clear paper jams” on page 171
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7  Print from your computer

The HP All-in-One can be used with any software application that allows printing. You
can print a range of projects, such as borderless images, newsletters, greeting cards,
iron-on transfers, and posters.

This section contains the following topics:

Print from a software application

Make the HP All-in-One the default printer
Change the print settings for the current job
Change the default print settings

Printing shortcuts
Perform special print jobs

Stop a print job

Print from a software application

Most print settings are automatically handled by the software application. You need to
change the settings manually only when you change print quality, print on specific types
of paper or transparency film, or use special features.

To print from a software application

1.
2.
3.

Make sure you have paper loaded in the input tray.

On the File menu in your software application, click Print.

Select the HP All-in-One as the printer.

If you set the HP All-in-One as the default printer, you can skip this step. The HP All-
in-One will already be selected.

If you need to change settings, click the button that opens the Properties dialog box.
Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

B NOTE: When printing a photo, you must select options for the specific photo
paper and photo enhancement.

Select the appropriate options for your print job by using the features available in the
Advanced, Printing Shortcuts, Features, and Color tabs.

ﬁ} TIP: You can easily select the appropriate options for your print job by choosing
one of the predefined print tasks on the Printing Shortcuts tab. Click a type of
print task in the Printing Shortcuts list. The default settings for that type of print
task are set and summarized on the Printing Shortcuts tab. If necessary, you
can adjust the settings here and save your custom settings as a new printing
shortcut. To save a custom printing shortcut, select the shortcut and click Save
As. To delete a shortcut, select the shortcut and click Delete.

Click OK to close the Properties dialog box.
Click Print or OK to begin printing.
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Make the HP All-in-One the default printer

You can set the HP All-in-One as the default printer to use from all software applications.
This means that the HP All-in-One is automatically selected in the printer list when you
select Print from the File menu in a software application. The default printer is
automatically selected when you click the Print button in the toolbar of most software
applications. For more information, see the Windows Help.

Change the print settings for the current job

You can customize the print settings of the HP All-in-One to handle nearly any print task.
This section contains the following topics:

» Set the paper size
» Set the paper type for printing
* View the print resolution
Change the print speed or quality
Change the page orientation
* Scale the document size
* Change the saturation, brightness, or color tone
* Preview your print job

Set the paper size

The Size setting helps the HP All-in-One determine the printable area on the page. Some
of the paper size choices have a borderless equivalent, which allows you to print to the
top, bottom, and side edges of the paper.

Usually, you set the paper size in the software application you used to create your
document or project. However, if you are using custom-size paper, or if you cannot set
the paper size from your software application, you can change the paper size in the
Properties dialog box before printing.

To set the paper size

1. Make sure you have paper loaded in the input tray.

2. On the File menu in your software application, click Print.
3. Make sure the HP All-in-One is the selected printer.

4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

Click the Features tab.
6. Inthe Resizing Options area, click the appropriate paper size from the Size list.

The following table lists the suggested paper size settings for the different types of
paper you can load in the input tray. Make sure to look at the long list of choices in

<,
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the Size list to see if a defined paper size already exists for the type of paper you are

using.
Paper type Suggested paper size settings
CD/DVD tattoo paper 5x7in.
Copier, multi-purpose, or Letter or A4

plain papers

Envelopes

Appropriate listed envelope size

Greeting-card papers

Letter or A4

Index cards

Appropriate listed card size (if listed sizes are not appropriate,
you can specify a custom paper size)

Inkjet papers Letter or A4
Iron-on T-shirt transfers Letter or A4
Labels Letter or A4
Legal Legal

Letterhead Letter or A4

Panorama photo paper

Appropriate listed panorama size (if listed sizes are not
appropriate, you can specify a custom paper size)

Photo papers

10 x 15 cm. (with or without tab), 4 x 6 in. (with or without tab),
letter, A4, or appropriate listed size

Transparency films

Letter or A4

Custom-size papers

Custom paper size

Set the paper type for printing

If you print on special papers, such as photo paper, transparency film, envelopes, or
labels, or if you experience poor print quality, you can set the paper type manually.

To set the paper type for printing

Make sure you have paper loaded in the input tray.

On the File menu in your software application, click Print.
Make sure the HP All-in-One is the selected printer.

1.

2,
3.
4

o

Click the button that opens the Properties dialog box.
Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

Click the Features tab.

In the Basic Options area, click the appropriate paper type from the Paper Type list.

View the print resolution

The printer software displays the print resolution in dots per inch (dpi). The dpi varies
according to the paper type and print quality that you select in the printer software.
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To view the print resolution

1. Make sure you have paper loaded in the input tray.

2. On the File menu in your software application, click Print.
3. Make sure the HP All-in-One is the selected printer.

4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

Click the Features tab.

6. In the Print Quality drop-down list, select the appropriate print quality setting for your
project.

7. In the Paper Type drop-down list, select the type of paper that you have loaded.

8. Click the Resolution button to view the print resolution dpi.

<

Change the print speed or quality

The HP All-in-One automatically chooses a print quality and speed setting depending on
the paper type setting you select. You can also change the print quality setting to
customize the speed and quality of the print process.

To select a print speed or quality

1. Make sure you have paper loaded in the input tray.

2. On the File menu in your software application, click Print.
3. Make sure the HP All-in-One is the selected printer.

4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

Click the Features tab.

6. In the Print Quality drop-down list, select the appropriate quality setting for your
project.

o,

Bf NOTE: To view the maximum dpi that the HP All-in-One will print, click
Resolution.

7. In the Paper Type drop-down list, select the type of paper that you have loaded.

Change the page orientation

The page orientation setting allows you to print your document vertically or horizontally
on the page.

Usually, you set the page orientation in the software application you used to create your
document or project. However, if you are using custom-size or special HP paper, or if you
cannot set the page orientation from your software application, you can change the page
orientation in the Properties dialog box before printing.

To change the page orientation
1. Make sure you have paper loaded in the input tray.
2. On the File menu in your software application, click Print.
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3. Make sure the HP All-in-One is the selected printer.
4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. Click the Features tab.
6. Inthe Basic Options area, click one of the following:
« Click Portrait to print the document vertically on the page.
» Click Landscape to print the document horizontally on the page.

Scale the document size

The HP All-in-One allows you to print the document at a different size than the original.

To scale the document size

1. Make sure you have paper loaded in the input tray.

2. On the File menu in your software application, click Print.

3. Make sure the HP All-in-One is the selected printer.

4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,

Options, Printer Setup, Printer, or Preferences.

Click the Features tab.

6. In the Resizing options area, click Scale to paper size, and then click the
appropriate paper size from the drop-down list.

o

Change the saturation, brightness, or color tone

You can change the intensity of colors and the level of darkness in your printout by
adjusting the Saturation, Brightness, or Color Tone options.

To change the saturation, brightness, or color tone

1. Make sure you have paper loaded in the input tray.

2. On the File menu in your software application, click Print.
3. Make sure the HP All-in-One is the selected printer.

4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. Click the Color tab.

Preview your print job

You can preview your print job before sending it to the HP All-in-One. This helps to prevent
wasting paper and ink on projects that do not print as expected.

To preview your print job

1. Make sure you have paper loaded in the input tray.

2. On the File menu in your software application, click Print.
3. Make sure the HP All-in-One is the selected printer.
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4. Click the button that opens the Properties dialog box.
Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. Select the print settings appropriate for your project on each of the tabs in the dialog
box.

6. Click the Features tab.

7. Select the Show Preview Before Printing check box.

8. Click OK, and then click Print or OK in the Print dialog box.
Your print job displays in the preview window.

9. In the HP preview window, do one of the following:
+ To print, click Start Printing.
* To cancel, click Cancel Printing.

Change the default print settings

If there are settings that you frequently use for printing, you might want to make them the
default print settings so they are already set when you open the Print dialog box from
within your software application.

To change the default print settings
1. In the HP Solution Center, click Settings, point to Print Settings, and then click
Printer Settings.

2. Make changes to the print settings, and click OK.

Printing shortcuts

Use printing shortcuts to print with print settings that you use often. The printer software
has several specially designed printing shortcuts that are available in the Printing
Shortcuts list.

Bf NOTE: When you select a printing shortcut the appropriate printing options are
automatically displayed. You can leave them as is, change them, or create your own
shortcuts for commonly used tasks.

Use the Printing Shortcuts tab for the following print tasks:

General Everyday Printing: Print documents quickly.

+  Photo Printing-Borderless: Print to the top, bottom, and side edges of 10 x 15 cm
(4 x 6 inch) HP Photo Papers with or without a tear-off tab.

*  Photo Printing—With White Borders: Print a photo with a white border around the
edges.
Fast/Economical printing: Produce draft-quality printouts quickly.

* Presentation printing: Print high-quality documents, including letters and
transparencies.

+  Two-sided (Duplex) Printing: Print two-sided pages with the HP All-in-One.
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This section contains the following topics:

* Create printing shortcuts
* Delete printing shortcuts

Related topics

* “Print a borderless image” on page 90

*  “Print a photo on photo paper” on page 91

« “Print on transparencies” on page 96

»  “Print on both sides of the page” on page 93

Create printing shortcuts

In addition to the printing shortcuts that are available in the Printing Shortcuts list, you
can create your own printing shortcuts.

If you frequently print on transparency film, for example, you can create a printing shortcut
by selecting the Presentation Printing shortcut, changing the paper type to HP Premium
Inkjet Transparency Film, and then saving the modified shortcut under a new name; for
example, Transparency Presentations. After creating the printing shortcut, simply
select it when printing on transparency film rather than changing the print settings each
time.

To create a printing shortcut

1. On the File menu in your software application, click Print.
2. Make sure the HP All-in-One is the selected printer.

3. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

4. Click the Printing Shortcuts tab.
5. In the Printing Shortcuts list, click a printing shortcut.
The print settings for the selected printing shortcut are displayed.
6. Change the print settings to those you want in the new printing shortcut.

7. Inthe Type new shortcut name here box, type a name for the new printing shortcut,
and then click Save.
The printing shortcut is added to the list.

Delete printing shortcuts

You might want to delete printing shortcuts that you no longer use.

To delete a printing shortcut

1. On the File menu in your software application, click Print.
2. Make sure the HP All-in-One is the selected printer.

3. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

4. Click the Printing Shortcuts tab.
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5. In the Printing Shortcuts list, click the printing shortcut that you want to delete.
6. Click Delete.
The printing shortcut is removed from the list.

Bf NOTE: Only the shortcuts that you have created can be deleted. The original HP
shortcuts cannot be deleted.

Perform special print jobs

In addition to supporting standard print jobs, the HP All-in-One can perform special jobs
such as printing borderless images, iron-on transfers, and posters.

This section contains the following topics:

» Print a borderless image

* Print a photo on photo paper

»  Print custom CD/DVD labels

e Print using Maximum dpi

» Print on both sides of the page

»  Print a multiple-page document as a booklet

» Print multiple pages on a single sheet

» Print a multiple-page document in reverse order
* Reverse an image for iron-on transfers

* Print on transparencies

» Print a group of addresses on labels or envelopes
» Print a poster

» Print a Web page

Print a borderless image

Borderless printing lets you print to the top, bottom, and side edges of 10 x 15¢cm (4 x 6
inch) photo paper.

{} TIP: Forthe best results, use HP Premium Photo Papers or HP Premium Plus Photo
Papers to print your photos.

To print a borderless image

1. Load up to 10 x 15 cm (4 x 6 inch) paper in the photo tray or full-size photo paper in
the main input tray.

2. On the File menu in your software application, click Print.
Make sure the HP All-in-One is the selected printer.
4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. Click the Features tab.

d
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6.

9.

In the Size list, click the size of photo paper loaded in the photo tray.

If a borderless image can be printed on the specified size, the Borderless printing
check box is enabled.

In the Paper Type drop-down list, click More, and then select the appropriate paper
type.

E¥ NOTE: You cannot print a borderless image if the paper type is set to Plain
paper or to a type of paper other than a photo paper.

Select the Borderless printing check box if it is not already checked.
If the borderless paper size and paper type are not compatible, the HP All-in-One
software displays an alert and allows you to select a different type or size.

Click OK, and then click Print or OK in the Print dialog box.

Print a photo on photo paper

For high-quality photo printing, HP recommends you use HP Premium Plus Photo
Papers with the HP All-in-One.

To print a photo on photo paper

1.

2.
3.
4

o

10.
1.

12.

Remove all paper from the input tray, and then load the photo paper print side down.
On the File menu in your software application, click Print.

Make sure the HP All-in-One is the selected printer.

Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

Click the Features tab.

In the Basic Options area, select the appropriate photo paper type from the Paper
Type drop-down list.

In the Resizing Options area, click the appropriate paper size from the Size list.

If the paper size and paper type are not compatible, the HP All-in-One software
displays an alert and allows you to select a different type or size.

In the Basic Options area, select a high print quality, such as Best or Maximum
dpi from the Print Quality drop-down list.

In the HP Real Life technologies area, click the Photo fix drop-down list and select
from the following options:

» Off: applies no HP Real Life technologies to the image.
» Basic: automatically focuses the image; moderately adjusts image sharpness.

« Full: automatically lightens dark images; automatically adjusts sharpness,
contrast, and focus of images; automatically removes red-eye.

Click OK to return to the Properties dialog box.

If you want to print the photo in black and white, click the Color tab and select the
Print in grayscale check box.

Click OK, and then click Print or OK in the Print dialog box.
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Bf NOTE: Do not leave unused photo paper in the input tray. The paper might start to
curl, which could reduce the quality of your printout. Photo paper should be flat before
printing.

Print custom CD/DVD labels

You can use the HP Photosmart Software or online templates from the HP Web site to
create and print a custom label on CD/DVD tattoo paper. You can affix the printed CD/
DVD tattoo to any CD/DVD.

To print a CD/DVD tattoo

1. Use the HP Photosmart Software, or go to www.hp.com to access templates for
creating CD/DVD labels.

Load 13 x 18 cm (5 x 7 inch) CD/DVD tattoo paper in the main input tray.
On the File menu in your software application, click Print.

Make sure the HP All-in-One is the selected printer.

Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

Click the Features tab.

7. Inthe Paper Type drop-down list, click More, and then select HP CD/DVD tattoo
paper from the list.

8. Click OK, and then click Print or OK in the Print dialog box.

o obd

o

Print using Maximum dpi
Use Maximum dpi mode to print high-quality, sharp images.

To get the most benefit from Maximum dpi mode, use it to print high-quality images such
as digital photographs. When you select the Maximum dpi setting, the printer software
displays the optimized dots per inch (dpi) that the HP All-in-One will print.

Printing in Maximum dpi takes longer than printing with other settings and requires a
large amount of disk space.

To print in Maximum dpi mode

1. Make sure you have paper loaded in the input tray.

2. On the File menu in your software application, click Print.
3. Make sure the HP All-in-One is the selected printer.

4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

Click the Features tab.
6. Inthe Paper Type drop-down list, click More, and then select the appropriate paper
type.

¢
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7.

8.

In the Print Quality drop-down list, click Maximum dpi.

BY NOTE: To view the maximum dpi that the HP All-in-One will print, click
Resolution.

Select any other print settings that you want, and then click OK.

Print on both sides of the page

You can print two-sided pages with the HP All-in-One. When printing two-sided pages,
make sure to use paper that is thick enough so that images do not show through to the
other side.

To print on both sides of the page

1.

2.
3.
4

o

Load paper into the input tray.

On the File menu in your software application, click Print.
Make sure the HP All-in-One is the selected printer.

Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

Click the Features tab.
In the Paper saving options area, select Two-sided printing.
Click OK, and then click Print or OK in the Print dialog box.

Related topics
“‘Recommended papers for printing and copying” on page 73

Print a multiple-page document as a booklet

The HP All-in-One allows you to print your document as a small booklet, which you can
fold and then staple together.

For best results, design your document to fit on a multiple of four pages, such as an 8,
12, or 16-page program for a child's school play or for a wedding.

To print a multiple-page document as a booklet

1.

b

Load paper into the input tray.
The paper should be thick enough so that the images do not show through to the
other side.

On the File menu in your software application, click Print.
Make sure the HP All-in-One is the selected printer.
Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

Click the Features tab.
In the Paper saving options area, select Two-sided printing.
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7. Select the binding edge from the Booklet layout is list, as appropriate for your
language.
+ If your language reads left-to-right, click Left edge binding.
» If your language reads right-to-left, click Right edge binding.
The Pages per sheet box is automatically set to two pages per sheet.

8. Click OK, and then click Print or OK in the Print dialog box.
The HP All-in-One begins printing.

9. Wait until the HP All-in-One has stopped printing for several seconds before removing
any of the printed pages from the output tray.
If you remove the pages while the document is still printing, the pages might get out
of order.

10. When the entire document has finished printing, fold the stack of paper in half, so that
the first page is on top, then staple the document along the crease.

{r TIP: For best results, use a saddle stapler, or a heavy-duty stapler with a long
reach to staple the booklet.

13-

Figure 7-2 Right-edge binding for right-to-left languages
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Print multiple pages on a single sheet

You can print up to 16 pages on a single sheet of paper.

To print multiple pages on a single sheet

1.

PN

No o

@

©

Make sure you have paper loaded in the input tray.

On the File menu in your software application, click Print.
Make sure the HP All-in-One is the selected printer.

Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

Click the Features tab.

In the Pages per sheet list, click 2, 4, 6, 8,9, or 16.

If you want a border to appear around each page image printed on the sheet of paper,
select the Print page borders check box.

In the Page order list, click an appropriate page order option.

The sample output graphic is numbered to show how the pages will be ordered if you
select each option.

Click OK, and then click Print or OK in the Print dialog box.

Print a multiple-page document in reverse order

Because of the way the paper feeds through the HP All-in-One, the first page that prints
is print side up at the bottom of the stack. Usually this means you need to put the printed
pages in the correct order.

RPN WO

N\W\

=

A better way is to print the document in reverse order so that the pages are stacked
correctly.

U WN

WW\

=

Q TIP: Set this option as a default setting so you do not have to remember to set it

every time you print a multiple-page document.
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To print a multiple-page document in reverse order

1.

2.
3.
4

<

Make sure you have paper loaded in the input tray.

On the File menu in your software application, click Print.
Make sure the HP All-in-One is the selected printer.

Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

Click the Advanced tab.
In the Layout Options area, select Front to Back in the Page Order option.

BY NOTE: If you set your document to print on both sides of the page, the Front to
Back option is not available. Your document will automatically print in the correct
order.

Click OK, and then click Print or OK in the Print dialog box.

BY NOTE: When you are printing multiple copies, each set is printed completely
before the next set is printed.

Reverse an image for iron-on transfers

This feature reverses an image so you can use it for iron-on transfers. This feature is also
useful for transparencies when you want to make notations on the back of the
transparency without scratching the original.

To reverse an image for iron-on transfers

1.
2.
3.

o

© e N

On the File menu in your software application, click Print.
Make sure the HP All-in-One is the selected printer.
Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

Click the Features tab.

In the Paper Type drop-down list, click More, and then select HP Iron-on Transfer
from the list.

If the selected size is not what you want, click an appropriate size in the Size list.
Click the Advanced tab.

In the Printer Features area, select On from the Mirror Image drop-down list.
Click OK, and then click Print or OK in the Print dialog box.

BY NOTE: To preventjams, manually feed the iron-on transfer sheets into the input
tray one sheet at a time.

Print on transparencies

For the best results, HP recommends you use HP transparency products with the HP All-
in-One.
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To print on transparencies

1.

2.
3.
4

i

Load the transparency into the input tray.

On the File menu in your software application, click Print.
Make sure the HP All-in-One is the selected printer.

Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

Click the Features tab.
In the Paper Type drop-down list, click More, and then select the appropriate paper
type.

ﬁ} TIP: If you want to make notations on the back of the transparencies and erase
them later without scratching the original, click the Advanced tab, and select the
Mirror Image check box.

In the Resizing Options area, click an appropriate size in the Size list.
Click OK, and then click Print or OK in the Print dialog box.

BY NOTE: The HP All-in-One automatically waits for transparencies to dry before
releasing them. Ink dries slower on film than on plain paper. Make sure you allow
enough time for the ink to dry before handling the transparency.

Print a group of addresses on labels or envelopes

With the HP All-in-One, you can print on a single envelope, a group of envelopes, or label
sheets designed for inkjet printers.

To print a group of addresses on labels or envelopes

1.
2,

Print a test page on plain paper first.

Place the test page on top of the label sheet or envelope, and hold both up to the
light. Check the spacing for each block of text. Make adjustments as needed.

Load the labels or envelopes into the main input tray.

/\ CAUTION: Do not use envelopes with clasps or windows. They can get stuck in
the rollers and cause paper jams.

Slide the paper-length and paper-width guides inward against the stack of labels or
envelopes until the guides stop.

If you are printing on envelopes, do the following:

a. Display the print settings, and click the Features tab.

b. Inthe Resizing Options area, click the appropriate envelope size in the Size list.
Click OK, and then click Print or OK in the Print dialog box.
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Print a poster

You can create a poster by printing a document on multiple pages. The HP All-in-One
prints dotted lines on some pages to indicate where to trim the pages before taping them
together.

-

To print a poster

1.

2.
3.
4

o

Make sure you have paper loaded in the input tray.

On the File menu in your software application, click Print.
Make sure the HP All-in-One is the selected printer.

Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

Click the Advanced tab.

Expand Document Options, and then expand Printer Features.

In the Poster Printing drop-down list, click either 2x2 (4 sheets), 3x3 (9 sheets),
4x4 (16 sheets), or 5x5 (25 sheets).

This selection tells the HP All-in-One to enlarge your document so that it fits on 4, 9,
16, or 25 pages.

If your originals are of multiple pages, each of those pages will be printed on 4, 9, 16,
or 25 pages. For example, if you have a one-page original and you select 3x3, you
will get 9 pages; if you select 3x3 for a two-page original, 18 pages will print.

Click OK, and then click Print or OK in the Print dialog box.

After the poster has printed, trim the edges of the sheets and tape the sheets together.

Print a Web page

98

You can print a Web page from your Web browser on the HP All-in-One.

To print a Web page

1.
2.

Make sure you have paper loaded in the main input tray.

On the File menu in your Web browser, click Print.
The Print dialog box appears.
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3. Make sure the HP All-in-One is the selected printer.

4. If your Web browser supports it, select the items on the Web page that you want to
include in the printout.
For example, in Internet Explorer, click the Options tab to select options such as As
laid out on screen, Only the selected frame, and Print all linked documents.

5. Click Print or OK to print the Web page.

O TIP: To print Web pages correctly, you might need to set your print orientation to
Landscape.

Stop a print job

Although you can stop a print job from either the HP All-in-One or the computer, HP
recommends you stop it from the HP All-in-One for best results.

Br NOTE: Although most software applications designed for Windows use the
Windows print spooler, your software application might not use the spooler. An
example of a software application that does not use the Windows print spooler is
PowerPoint in Microsoft Office 97.

If you cannot cancel your print job by using one of the following procedures, consult
the instructions for canceling background printing in the online help for your software
application.

To stop a print job from the HP All-in-One
A Press Cancel on the control panel. If the print job does not stop, press Cancel again.
It can take a few moments for the print job to be cancelled.

To stop a print job from the computer (Windows 2000 users)
1. On the Windows taskbar, click Start, point to Settings, and then click Printers.
2. Double-click the HP All-in-One icon.

X¥ TIP: You can also double-click the printer icon in the Windows taskbar.

3. Select the print job you want to cancel.

4. On the Document menu, click Cancel Printing or Cancel, or press the Delete key
on your keyboard.
It can take a few moments for the print job to be cancelled.

To stop a print job from the computer (Windows XP users)

1. On the Windows taskbar, click Start, and then click Control Panel.
2. Open the Printers and Faxes control panel.

3. Double-click the HP All-in-One icon.

X¥ TIP: You can also double-click the printer icon in the Windows taskbar.
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4. Select the print job you want to cancel.

5. On the Document menu, click Cancel Printing or Cancel, or press the Delete key
on your keyboard.
It can take a few moments for the print job to be cancelled.

To stop a print job from the computer (Windows Vista users)

1. On the Windows taskbar, click Start, and then click Control Panel.
2. Click Printers.

3. Double-click the HP All-in-One icon.

% TIP: You can also double-click the printer icon in the Windows taskbar.

4. Select the print job you want to cancel.

5. On the Document menu, click Cancel Printing or Cancel, or press the Delete key
on your keyboard.
It can take a few moments for the print job to be cancelled.
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Use the photo features

The HP All-in-One is equipped with memory card slots and a front USB port that enable
you to print or edit photos from a memory card or storage device (such as a keychain
drive, portable hard drive, or a digital camera in storage mode) without uploading your
photos to a computer first. Additionally, if the HP All-in-One is network-connected or
connected to a computer with a USB cable, you can also transfer your photos to the
computer to print, edit, or share.

The HP All-in-One supports the memory cards described below. Each type of memory
card can only be inserted in the appropriate slot for that card, and only one card may be
inserted at a time.

/\ CAUTION: Do not insert more than one memory card at a time. If more than one
memory card is inserted, unrecoverable data loss might occur.

i
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MultiMediaCard w-
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1 | CompactFlash (CF) types | and Il

2 | Secure Digital (SD), Secure Digital Mini (adapter required), Secure Digital High Capacity
(SDHC), MultiMediaCard (MMC), MMC Plus, MMC Mobile (RS-MMC; adapter required),
TransFlash MicroSD Card, or Secure MultiMedia Card

3 | Memory Stick, Memory Stick Pro, Memory Stick Select, Memory Stick Magic Gate, Memory
Stick Duo or Duo Pro (adapter optional), or Memory Stick Micro (adapter required)

4 | Front USB port (for storage devices)
xD-Picture Card

Use the photo features 101



Chapter 8

The memory card area also has a Photo light. This light blinks green when a memory
card is being read or when an image is being printed from a card, and stays solid green
when images are ready to be viewed. The Photo light is located near the memory card
slots and is indicated by a camera icon.

/\ CAUTION: Do not pull out the memory card or storage device while the Photo light
is flashing. A flashing light means the HP All-in-One is accessing the memory device.
Wait until the light remains solid. Removing a memory card or storage device while it
is being accessed might corrupt information on the memory device or damage the
HP All-in-One, memory card, or storage device.

This section contains the following topics:

* View and select photos

*  Print your photos

» Create special projects from your photos

» Share photos using HP Photosmart Software
» Save photos to your computer

» Edit photos using the control panel

View and select photos

You can view and select photos on your memory card or storage device before or while
printing them.
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To view and select photos
1.

Insert a memory card into the appropriate slot on the HP All-in-One, or connect a
storage device to the front USB port.

The Photosmart Express menu appears, with the most recent photo shown on the
display.

View

Print Create Share Save

Load up to 10 x 15 cm (4 x 6 inch) photo paper in the photo tray or full-size photo
paper in the main input tray.

With View highlighted, press OK.

The View Photos screen appears.

Press « or > to scroll through the thumbnails of your photos.

When the thumbnail of the photo you want to view is highlighted, press OK.

When the photo appears by itself on the display, press OK again.

The Photo Options screen appears.

With Print Preview highlighted, press OK.

The Print Preview screen appears, showing how your photo will look when printed.
If you want to select additional photos to view and print, press ¥ to highlight Add
More, press OK, and repeat steps 4-6.

Or, once you're in the Add Photos screen, the quickest way to select multiple photos
(if you don't need the option to edit them) is to press A to select a photo, and then
press « or p> to scroll through more photos to select.

ﬁ} TIP: A checkmark appears to indicate each photo that is selected. You can
change the number of copies by pressing A or ¥. The total number of photos that
will print appears at the top of the display.
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9. (Optional) If you want to check and/or modify any of your print settings, press ¥ to
highlight Settings and press OK.

10. To print the photo(s), use A or ¥ to highlight Print Now and press OK (or press Print
Photos on the control panel).
A print status screen displays the number of pages to print and the estimated time to
complete.

&} TIP: During printing, you can highlight Add more photos and press OK to add
more photos to the print queue.

Print your photos

104

You can print the photos on your memory card or storage device in a variety of sizes,
from 10 x 15 cm (4 x 6 inch) up to the size of letter or A4 paper, including multiple small-
size photos on a single page.

To print your photos

{} TIP: If you want to print only a single borderless 10 x 15 cm (4 x 6 inch) photo on 10
x 15 cm (4 x 6 inch) paper, a shortcut is to simply press Print Photos twice on the
control panel (once to display the Print Preview screen and once to start the print
job).

1. Insert a memory card into the appropriate slot on the HP All-in-One, or attach a
storage device to the front USB port.
The Photosmart Express menu appears, with the most recent photo shown on the

display.
i 3\\
View
® ¥ 5
N ]
Print Create Share Save
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10.

1.

Load up to 10 x 15 cm (4 x 6 inch) paper in the photo tray or full-size photo paper in
the main tray.

Press P until Print is highlighted, and then press OK.

The Layout screen appears.

Press q or P to scroll through the layout options, and press OK when the option you
want is highlighted:

Ny N
< Bx | >

4x6 5x7

The Select Photos screen appears.

Press < or p> to scroll through the thumbnails of the photos.

When you have highlighted the thumbnail of the photo you want to print, press OK.
When the chosen photo appears by itself on the display, press A to select it.

A checkmark appears to indicate that the photo is selected. You can change the
number of copies by pressing A or ¥. The total number of photos that will print
appears at the top of the display.

Press < or p» to continue scrolling through and selecting photos, and then press
OK.

The Photo Options menu appears.

With Print Preview highlighted, press OK.

The Print Preview screen appears, showing how your photo(s) will look when printed.
(Optional) If you want to check and/or modify any of your print settings, use A or

V¥ to highlight Settings and press OK.

Use A or V¥ to highlight Print Now and press OK (or press Print Photos on the
control panel).

A print status screen displays the number of pages to print and the estimated time to
complete.

Create special projects from your photos

The HP All-in-One enables you to create special projects from your photos, including:

Photo albums
Panorama prints
Wallet-size photos
Passport-size photos
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To create special projects

1. Insert a memory card into the appropriate slot on the HP All-in-One, or connect a
storage device to the front USB port.
The Photosmart Express menu appears, with the most recent photo shown on the
display.

View
AN
Print Create Share Save

2. Make sure the photo tray or main input tray is loaded with the correct paper for the
type of project you are creating.
3. Press g or P to highlight Create, and then press OK.

The Create screen appears.

4. Press { or p to scroll through the projects, and then press OK to select the project
you want:

* Album Pages: Enables you to select multiple photos and print them onto a series
of themed album pages, which you can then bind to create a photo album. The
photos in your album pages are placed in the same orientation for a visually
pleasing presentation.

+ Panorama Prints: Enables you to select multiple photos to "stitch" together to
create a single wide view (or panorama) photo. The HP All-in-One automatically
aligns the edges of the photos you select to create the smoothest transition from
one photo to the next.

* Wallets: Enables you to print your own wallet-size photos to carry with you or give
to friends or relatives.

+ Passport Photos: Enables you to print your own passport-size photos. (If you
have questions on guidelines or restrictions for passport photos, contact a local
passport service agency.)
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Share photos using HP Photosmart Software

You can use the HP Photosmart Software installed on your computer to transfer photos
from a memory card or storage device to your computer’s hard drive for sharing photos
online and printing from your computer.

Before transferring photos to your computer, you need to remove the memory card from
your digital camera and insert it in the appropriate memory card slot on the HP All-in-One,

Respond to the prompts for the project you are creating.

At the Print Preview screen, highlight Print Now, and then press OK.

A print status screen displays the number of pages to print and the estimated time to
complete.

or connect a storage device to the front USB port.

To send photos from a memory card or storage device

1.

Insert a memory card into the appropriate slot on the HP All-in-One, or connect a
storage device to the front USB port.

The Photosmart Express menu appears, with the most recent photo shown on the
display.

View
= 37 >
= \ |
XR°
Print Create Share Save

Press P until Share is highlighted, and then press OK.

The Share Photos screen appears.

Press < or p> to scroll through the thumbnails of your photos.

When you have highlighted the thumbnail of the photo you want to share, press
OK.

When the chosen photo appears by itself on the display, press A to select it.

A checkmark appears to indicate that the photo is selected.
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6. Press «qor p to continue scrolling through and selecting photos, and then press
OK.
The Share Options screen appears.

7. Press A or V¥ to highlight Share, and then press OK.
If the HP All-in-One is network-connected, a list of available computers appears.
Select the computer you want to use to send the photos, and then continue to the
next step.

8. When the Share Not Finished message appears, press OK and then follow the
onscreen prompts on your computer.

Save photos to your computer

108

You can use the HP Photosmart Software installed on your computer to transfer photos
from a memory card or storage device to your computer’s hard drive for sharing photos
online and printing from your computer.

Before transferring photos to your computer, you need to remove the memory card from
your digital camera and insert it in the appropriate memory card slot on the HP All-in-One,
or connect a storage device to the front USB port.

To save photos

1. Insert a memory card into the appropriate slot on the HP All-in-One, or connect a
storage device to the front USB port.
The Photosmart Express menu appears, with the most recent photo shown on the

display.

. “
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Edit photos using the control panel

The HP All-in-One offers several basic editing features that you can use to edit your

Press P until Save is highlighted, and then press OK.

If the HP All-in-One is network-connected, a list of available computers appears.
Select the computer to which you want to transfer the photos, and then continue to
the next step.

When the Save to Computer screen asks you to see the computer monitor for Import
photo options, follow the onscreen prompts on your computer to save the photos to
your computer.

Only images that were not previously saved are copied to your computer.

photos manually before you print them, as well as a feature that enables you to
automatically enhance your photos.

This section contains the following topics:

Zoom and pan to crop a photo

Rotate a photo

Adjust the brightness of your photos
Apply special color effects to your photos

Remove red-eye
Automatically enhance your photos

Zoom and pan to crop a photo

The HP All-in-One enables you to zoom in or out on a specific area of a photo. When you
print the photo, the photo is cropped so only the area shown on the display prints.

BY NOTE: The changes you make to the photo apply only to viewing and printing the

photo. The changes will not be saved on the memory card or storage device.

To crop a photo

1.

Insert a memory card into the appropriate slot on the HP All-in-One, or connect a
storage device to the front USB port.

The Photosmart Express menu appears, with the most recent photo shown on the
display.

With View highlighted, press OK.

You can use 4 or p> for highlighting options.

The View Photos screen appears.

Press « or p» to scroll through the thumbnails of your photos.

When the thumbnail of the photo you want to edit is highlighted, press OK.

When the selected photo appears by itself on the display, press OK again to display
the Photo Options menu.

In the Photo Options menu, use A or ¥ to highlight Edit Photo, and then press
OK.

The Edit Photo menu appears.
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7. Use A or V to highlight Crop, and then press OK.
The Crop screen appears.

8. Press Zoom In or Zoom Out to zoom closer to or farther away from the subject of
the photo.
An outline appears on the photo to show you an approximate view of the area that
will print.

9. Press the arrows on the directional pad to pan around the photo and select a specific
area to print.

10. Press OK to crop the photo.

Rotate a photo

Depending how a photo is saved, the photo might appear sideways or upside down on
the display. You might need to rotate the photo to make it show or print properly.

Bf NOTE: When printing more than one photo on a page, the HP All-in-One
automatically adjusts the orientation of your photos to fit a maximum number of photos
on the page. The rotation you apply here is ignored to accommodate the number of
photos selected per page.

To rotate a photo

1. Insert a memory card into the appropriate slot on the HP All-in-One, or connect a
storage device to the front USB port.

The Photosmart Express menu appears, with the most recent photo shown on the
display.
2. With View highlighted, press OK.
You can use « or p> for highlighting options.
The View Photos screen appears.
3. Press € or P to scroll through the thumbnails of your photos.
4. When the thumbnail of the photo you want to edit is highlighted, press OK.

5. When the selected photo appears by itself on the display, press OK again to display
the Photo Options menu.

6. Inthe Photo Options menu, use A or ¥ to highlight Edit Photo, and then press
OK.
The Edit Photo menu appears.

7. Use A or V¥ to highlight Rotate, and then press OK.
The Rotate screen appears.

8. Use «or ) to flip the image 90 degrees clockwise or counterclockwise.

9. When you are done rotating the image, press OK.

Adjust the brightness of your photos

You can adjust the brightness of a photo so that it prints lighter or darker than the original
photo you took with your digital camera.

Bf NOTE: The changes you make to the photo apply only to viewing and printing the
photo. The changes will not be saved on the memory card or storage device.
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To adjust the brightness
1.

Insert a memory card into the appropriate slot on the HP All-in-One, or connect a
storage device to the front USB port.

The Photosmart Express menu appears, with the most recent photo shown on the
display.

With View highlighted, press OK.

You can use « or p> for highlighting options.

The View Photos screen appears.

Press € or p> to scroll through the thumbnails of your photos.

When the thumbnail of the photo you want to edit is highlighted, press OK.

When the selected photo appears by itself on the display, press OK again to display
the Photo Options menu.

In the Photo Options menu, use A or ¥ to highlight Edit Photo, and then press
OK.

The Edit Photo menu appears.

Use A or V¥ to highlight Brightness, and then press OK.

The Brightness screen appears.

Press « or > to increase or decrease the brightness of the photo.

The current brightness selection is indicated by the vertical line on the slidebar.
When you are done adjusting brightness, press OK.

Apply special color effects to your photos

You can apply special color effects to a photo so that it prints with a sepia, hand-tinted,
or black-and-white finish.

Br NOTE: The changes you make to the photo apply only to viewing and printing the

photo. The changes will not be saved on the memory card or storage device.

To change the color effects

1.

Insert a memory card into the appropriate slot on the HP All-in-One, or connect a
storage device to the front USB port.

The Photosmart Express menu appears, with the most recent photo shown on the
display.

With View highlighted, press OK.

You can use « or p> for highlighting options.

The View Photos screen appears.

Press < or p to scroll through the thumbnails of your photos.

When the thumbnail of the photo you want to edit is highlighted, press OK.

When the selected photo appears by itself on the display, press OK again to display
the Photo Options menu.

In the Photo Options menu, use A or ¥ to highlight Edit Photo, and then press
OK.

The Edit Photo menu appears.
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7. Use A or Vv to highlight Color Effect, and then press OK.
The Color Effect menu appears.
8. Use A or V¥ to select one of the following color effect options, and then press OK:

No Effect Does not apply any special color effects to your photo.

Black & White Prints the photo in black and white.

Sepia Applies brown tones, similar to photos produced in the early 1900s, to
your photo.
Antique Applies brown tones along with some pale colors to your photo. With

this option, your photo will look like it was hand-tinted.

The selected color effect is applied to the photo, and the photo is shown by itself on
the display.

Remove red-eye

The flash on a camera (especially on older model cameras) can sometimes cause a
subject's eyes to appear red in your photos. You can remove redness so that eyes appear
the correct shade in your photos.

To remove red-eye from photos

1. Insert a memory card into the appropriate slot on the HP All-in-One, or connect a
storage device to the front USB port.
The Photosmart Express menu appears, with the most recent photo shown on the
display.

2. With View highlighted, press OK.
You can use <« or P for highlighting options.
The View Photos screen appears.

3. Press « or ) to scroll through the thumbnails of your photos.

4. When the thumbnail of the photo you want to edit is highlighted, press OK.

5. When the selected photo appears by itself on the display, press Red Eye Removal
on the control panel.

{'} TIP: Another method is to choose Red Eye Removal from the Edit Photo menu.

A red-eye icon blinks in the upper left corner of the photo, red-eye removal is applied,
and the photo is shown by itself on the display.

Automatically enhance your photos

The HP All-in-One is set up, by default, to enhance your photos automatically when you
print them. The changes are only visible on your printed output; you cannot see the
changes on the display.

When this feature is enabled, the HP All-in-One uses HP Real Life Technologies to:

» Adjust the brightness or darkness of your photos.
» Adjust the lighting to make dark images appear brighter.
»  Sharpen blurry images.
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You can turn off the automatic photo enhancement feature for individual photos, on a per-
image basis.

To turn off automatic photo enhancement

1.

Insert a memory card into the appropriate slot on the HP All-in-One, or connect a
storage device to the front USB port.

The Photosmart Express menu appears, with the most recent photo shown on the
display.

With View highlighted, press OK.

You can use  or p> for highlighting options.

The View Photos screen appears.

Press « or p> to scroll through the thumbnails of your photos.

When the thumbnail of the photo you want to edit is highlighted, press OK.

When the selected photo appears by itself on the display, press OK again to display
the Photo Options menu.

In the Photo Options menu, use A or ¥ to highlight Edit Photo, and then press
OK.

The Edit Photo menu appears.

Use A or ¥ to highlight Photo Fix, and then press OK.

The Photo Fix menu appears.

To turn off automatic photo enhancement, use A or ¥ to select Off, and then press
OK.
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9 Use the scan features

Scanning is the process of converting text and pictures into an electronic format for your
computer. You can scan almost anything (photos, magazine articles, film negatives,
slides, and text documents) on the HP All-in-One.

You can use the scanning features of the HP All-in-One to do the following:

« Make reprints of your favorite photos.
+ Scan text from an article into your word processor and quote it in a report.

« Print business cards and brochures by scanning a logo and using it in your publishing
software.

« Send photos to friends and relatives by scanning your favorite prints and including
them in e-mail messages.

« Create a photographic inventory of your house or office.
* Archive treasured photos in an electronic scrapbook.
This section contains the following topics:

* Make reprints of your photos

* Scan animage

« Edit a scanned image

« Share a scanned image with friends and relatives

» Stop scanning

Make reprints of your photos

You can scan a printed copy of a photo to make reprints in a variety of sizes, up to the
size of letter (8.5 x 11 inch) or A4 (210 x 297 mm) paper.

By default, the HP All-in-One is set to detect the type of paper you are using automatically.
For the best results when reprinting photos, leave the Paper Type set to Automatic, and
load photo paper in the HP All-in-One. You should only change the Paper Type if you
see print quality issues using the Automatic setting.
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To reprint an original photo
1. Press Reprints for the Scan and Reprint option.

Bf NOTE: You can also press Scan Menu on the control panel for the Scan and

Reprint option.

NOTE: Depending on the paper size you choose, you can place the photo paper
in the photo tray or the main input tray.

2. When prompted, load your original photo print side down on the right front corner of
the glass, and then do one of the following:

To reprint your original photo using the default print settings
A Press Print Photos on the control panel.

To change print settings before reprinting your original photo

a.

b.

Press OK to change print settings.

The Source of Original screen appears.

Press A or ¥ to highlight any option and press OK.

The Print Layout screen appears.

Press A or ¥ to highlight the print layout pattern and press OK.

Bf NOTE: Depending on the paper size you choose, you might be prompted to
choose a layout for the photos on your pages.

The Scan Preview menu appears.
Press A or ¥ to adjust the number of copies and press OK.
The Reprint Options screen appears.

Bf NOTE: The HP All-in-One scans your original and shows a preview of the
photo on the display.

Press OK to select Print Preview .

BY NOTE: Select Edit Photo to edit photos before printing.

The Print Preview screen appears.

Press A or ¥ to highlight Print Now and press OK (or press Print Photos on the
control panel).

Scan an image

You can start a scan from your computer or from the control panel of the HP All-in-One.
This section explains how to scan from the control panel of the HP All-in-One only.
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B NOTE: You can also use the software you installed with the HP All-in-One to scan
images. Using this software, you can edit a scanned image and create special projects
using a scanned image.

To use the scan features, the HP All-in-One and computer must be connected and turned
on. The HP All-in-One software must also be installed and running on your computer prior
to scanning. To verify that the HP All-in-One software is running on a Windows computer,
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look for the HP All-in-One icon in the system tray at the lower right side of the screen,
near the time.

BY NOTE: Closing the HP Digital Imaging Monitor icon in the Windows system tray
can cause the HP All-in-One to lose some of its scan functionality. If this happens,
you can restore full functionality by restarting your computer or by starting the
HP Photosmart Software.

This section contains the following topics:

e Scan an original to a computer
e Scan an original to a memory card or storage device

Scan an original to a computer

You can scan originals placed on the glass by using the control panel.

To scan to a computer
1. Load your original print side down on the right front corner of the glass.
2. Press Scan Menu.
3. Press ¥ to highlight Scan to Computer, and then press OK.
4. If the HP All-in-One is connected to one or more computers on a network, do the
following:
a. Press OK to select Select Computer.
A list of the computers connected to the HP All-in-One appears on the display.

BY NOTE: The Select Computer menu might list computers with a USB
connection in addition to those connected through the network.

b. Press OKto select the default computer, or press ¥ to select a different computer,
and then press OK.

The Scan To menu appears on the display, listing the applications on the selected
computer.

If the HP All-in-One is connected directly to a computer with a USB cable, proceed
to step 5.

5. Press OK to select the default application to receive the scan, or press ¥ to select a
different application, and then press OK.
A preview image of the scan appears on your computer, where you can edit it.

6. Make any edits to the preview image, and then click Accept when you are finished.

Related topics
*  “Control panel features” on page 13
*  “Scan Menu” on page 17

Scan an original to a memory card or storage device

You can send the scanned image as a JPEG image to the memory card that is currently
inserted or a storage device that is currently attached to the front USB port. This enables
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you to use the photo print options to print borderless prints and album pages from the
scanned image.

F.%i" NOTE: If the HP All-in-One is connected to a network, you can access the scanned
image only if the card or device is being shared across the network.

To save a scan to a memory card or storage device

1. Make sure your memory card is inserted into the appropriate slot on the HP All-in-
One, or a storage device is connected to the front USB port.

2. Load your original print side down on the right front corner of the glass.
3. Press the Scan Menu button.
4. Press ¥ to highlight Scan to Memory Card, and then press OK.

The HP All-in-One scans the image and saves the file to the memory card or storage
device in the JPEG format.

Edit a scanned image

You can edit a scanned image using the software you installed with the HP All-in-One.
You can also edit a scanned document by using your Optical Character Recognition
(OCR) software.

B NOTE: Ifyou are using HP Photosmart Essential, the Optical Character Recognition
(OCR) software might not be installed on your computer. To install the OCR software,
you must re-insert the software disk and select OCR under the Custom installation
options.

This section contains the following topics:
» Edit a scanned preview image

» Edit a scanned photo or graphic

» Edit a scanned document

Edit a scanned preview image

You can use the tools in the HP Scanning software to modify a preview image. Any
changes that you make, such as brightness, image type, resolution, and more apply only
to this scan session.

You can make additional changes in the HP Photosmart software after the image is
scanned.

Edit a scanned photo or graphic

You can edit a scanned photo or graphic using the software you installed with the HP All-
in-One. Using this software, you can rotate or crop the image, as well as adjust the
brightness, contrast, and color saturation.

Edit a scanned document

Scanning text (also known as optical character recognition or OCR) enables you to bring
the content of magazine articles, books, and other printed matter into your favorite word
processor and many other programs as fully editable text. Learning to work with OCR
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correctly is important if you want to obtain the best results. Do not expect scanned text
documents to be letter-perfect the first time you use your OCR software. Using OCR
software is an art that takes time and practice to master.

BY NOTE: Ifyou are using HP Photosmart Essential, the Optical Character Recognition

(OCR) software might not be installed on your computer. To install the OCR software,
you must re-insert the software disk and select OCR under the Custom installation
options.

Share a scanned image with friends and relatives

You can easily share scanned images with friends and family using the HP Photosmart

Share online service. HP Photosmart Share enables you to send images to others as e-
mail or upload photos to an online photo album or photo finishing service.

Br NOTE: Availability of the services described here varies by country/region. Some of

To send a scan of a photo or document
1.
2.
3.

the services described here might not be available in your country/region.

Load your original print side down on the right front corner of the glass.

Press Scan Menu.

Press OK to select HP Photosmart Share and send the scan to your computer. If
the HP All-in-One is connected to one or more computers on a network, a Select
Computer menu appears. Select the destination computer name.

Use the HP Photosmart Share Software on your computer to send the scan as
thumbnail preview to an e-mail recipient (the full-size file can be downloaded later, at
the recipient's convenience), to an online photo album or photo finishing service, or
to a network-connected HP device.

The HP All-in-One sends the scanned photo or document to the computer or to all
the share destinations that you selected.

Related topics
“Share photos using HP Photosmart Software” on page 107

Stop scanning

To stop scanning
A Press Cancel on the control panel.
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10 Use the copy features

The HP All-in-One enables you to produce high-quality color and black-and-white copies
on a variety of paper types, including transparencies. You can enlarge or reduce the size
of an original to fit a specific paper size, adjust the darkness of the copy, and use special
features to make high-quality copies of photos, including borderless copies.

Q TIP: For the best copy performance on standard copy projects, set the paper size
to Letter or A4, the paper type to Plain Paper, and the copy quality to Fast.

This section contains the following topics:

* Make a copy

*  Preview your copy job

* Change the copy settings for the current job
* Change default copy settings

»  Perform special copy jobs

» Stop copying

Make a copy

You can make quality copies from the control panel.

To make a copy from the control panel
1. Make sure you have paper loaded in the input tray.

2. Load your original print side down on the right front corner of the glass or print side
up in the document feeder tray.

3. Press Start Copy Black or Start Copy Color to begin copying.

Related topics
“Load an original in the automatic document feeder” on page 71

Preview your copy job

After changing settings on the HP All-in-One for making a copy, you can preview an image
of the expected output on the display before starting the copy.

Copy

B NOTE: You must explicitly pick your copy settings to ensure an accurate preview.
Automatic settings will not reflect the loaded paper size and type, but use defaults
instead.

Previews appear when you select Preview on the Copy Menu, or when you use the crop
feature to specify a specific area of the original to copy.
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To preview your copy from the control panel
1. Press Copy Menu.
The Copy Menu appears.

2. Change copy settings on the HP All-in-One to accurately reflect the copy you want to
make.

3. Press ¥ to highlight Preview, and then press OK.
An image on the display shows how your copy will print.

4. Press Start Copy Black or Start Copy Color to accept the preview and begin
copying.

Change the copy settings for the current job

You can customize the copy settings of the HP All-in-One to handle nearly any copy task.
This section contains the following topics:

» Set the number of copies
Set the copy paper size
Set the copy paper type
* Change copy speed or quality
* Adjust the lightness and darkness of your copy

Set the number of copies

You can set the number of copies that you want to print by either using the Copy Menu
button on the control panel or by selecting the appropriate options in your software
application.

To set the number of copies from the control panel

1. Make sure you have paper loaded in the input tray.

2. Load your original print side down on the right front corner of the glass.

3. Press Copy Menu.
The Copy Menu appears.

4. Press V¥ to highlight Copies, and then press OK.
The Copies option appears.

5. Use the keypad or press A to select the number of copies, up to the maximum.
(The maximum number of copies varies by model.)

{r TIP: If you hold down either of the arrow buttons, the number of copies changes
by increments of 5 to make it easier to set a large number of copies.

6. Press Start Copy Black or Start Copy Color.
Set the copy paper size

You can set the paper size on the HP All-in-One. The paper size you select should match
what is loaded in the input tray.
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To set the paper size from the control panel

1. Press Copy Menu.
The Copy Menu appears.

2. Press ¥ to highlight Paper Size, and then press OK.

The Paper Size menu appears.

3. Press ¥ to highlight the appropriate paper size and then press OK.
Refer to the following table to determine which paper size setting to choose, based

on the paper loaded in the input tray.

Paper type

Suggested paper size settings

Copier, multi-purpose, or plain papers

8.5x11 inch or A4

Inkjet papers

8.5x11 inch or A4

Letterhead

8.5x11 inch or A4

Photo papers

10x15 cm

4x6 inch

13x18 cm

5x7 inch

8.5x11 inch

A4

L (Japan only)

2L (Japan only)

20x25 cm (Germany only)
Mutsugiri (Japan only)

Hagaki

Hagaki (Japan only)

Transparency films

8.5x11 inch or A4

Set the copy paper type

You can set the paper type on the HP All-in-One. The default paper type setting for
copying is Automatic, which causes the HP All-in-One to detect the type of paper in the

input tray.

To set the paper type for copies
1. Press Copy Menu.
The Copy Menu appears.

Copy

2. Press ¥ to highlight Paper Type, and then press OK.

The Paper Type menu appears.
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3. Press ¥ until the appropriate paper type appears.
Refer to the following table to determine which paper type setting to choose based
on the paper loaded in the input tray.

Paper type Control panel setting
Copier paper or letterhead Plain Paper

HP Bright White Paper Plain Paper

HP Premium Plus Photo Paper, Glossy Premium Photo

HP Premium Plus Photo Paper, Matte Premium Photo

HP Premium Plus 10 x 15 cm (4 x 6 inch) Premium Photo
Photo Paper

HP Premium Plus 13 x 18 cm (5 x 7 inch) Premium Photo

Photo Paper

HP Photo Paper Photo Paper

HP Everyday Photo Paper Everyday Photo

HP Everyday Photo Paper, Semi Gloss Everyday Matte

HP Premium Paper Premium Inkjet

Other inkjet paper Premium Inkjet

HP Professional Brochure & Flyer Paper Brochure Glossy

(Glossy)

HP Professional Brochure & Flyer Paper Brochure Matte

(Matte)

HP Premium or Premium Plus Inkjet Transparency

Transparency Film

Other transparency film Transparency

Plain Hagaki Plain Paper

Glossy Hagaki Premium Photo

L (Japan only) Premium Photo

Advanced Photo Paper Advanced Photo
4. Press OK.

Change copy speed or quality
The HP All-in-One provides four options that affect copy speed and quality:

+ Maximum dpi produces the highest quality for all paper. Maximum dpi copies slower
than the other quality settings.

- Best produces high quality for all paper and eliminates the banding (striping) effect
that sometimes occurs in solid areas. Best copies slower than the Normal or Fast
quality settings.
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+ Normal delivers high quality and is the recommended setting for most of your
copying. Normal copies faster than Best and is the default setting.

« Fast copies faster than the Normal setting. The text is comparable to the quality of
the Normal setting, but the graphics might be lower quality. The Fast setting uses
less ink and extends the life of your ink cartridges.

To change the copy quality from the control panel
1. Make sure you have paper loaded in the input tray.
2. Load your original print side down on the right front corner of the glass.
3. Press Copy Menu.
The Copy Menu appears.
4. Press ¥ to highlight Quality, and then press OK.
The Quality menu appears.
Press ¥ to select a copy quality.
Press OK.

S

Adjust the lightness and darkness of your copy

You can use the Lighter/Darker option to adjust the contrast of the copies you make.

To adjust the copy contrast from the control panel
1. Make sure you have paper loaded in the input tray.
2. Load your original print side down on the right front corner of the glass.
3. Press Copy Menu.
The Copy Menu appears.
4. Press ¥ to highlight Lighter/Darker, and then press OK.
The Lighter/Darker menu appears.
5. Do one of the following:
* Press ) to darken the copy.
* Press «to lighten the copy.
6. Press OK.

Change default copy settings

When you change copy settings from the control panel, the settings apply only to the
current copy job. To apply copy settings to all future copy jobs, you can save the settings
as defaults.

To set default copy settings from the control panel
1. Make any needed changes to the copy settings.
2. Press Copy Menu.
The Copy Menu appears.
3. Press ¥ to highlight Set As New Defaults, and then press OK.
4. Press ¥ to highlight Yes, change defaults, and then press OK.
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B NOTE: The settings you specify here are only saved on the HP All-in-One. They do
not adjust the settings in the software. You can save your most frequently used
settings by using the software that you installed with the HP All-in-One.

Perform special copy jobs

In addition to supporting standard copy jobs, the HP All-in-One can perform special jobs
such as copying borderless photos and resizing originals.

This section contains the following topics:

* Make a borderless copy of a photo

* Resize an original to fit onto letter or A4 paper
* Resize an original using custom settings

» Crop an original

»  Shift the left margin

+ Improve the quality of a copy

Make a borderless copy of a photo

For the best quality when copying a photo, load 10 x 15 cm (4 x 6 inch) photo paper in
the photo tray and change your copy settings for the correct paper type and photo
enhancement.

To make a borderless copy of a photo from the control panel
1. Load 10 x 15 cm (4 x 6 inch) photo paper into the photo tray.

2. Load your original photo print side down on the right front corner of the glass.
Position the photo on the glass so the long edge of the photo is along the front edge
of the glass, as indicated by the engraved guides along the edge of the glass.

3. Press Start Copy Black or Start Copy Color.

The HP All-in-One makes a 10 x 15 cm (4 x 6 inch) borderless copy of your original
photo.

BY NOTE: If you loaded tabbed paper in the photo tray, you can remove the tab
from the copy of your photo once the ink has completely dried.

{r TIP: If the output is not borderless, set the paper type to Premium Photo, and
then try making the copy again.
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Related topics
* “Load 10 x 15 cm (4 x 6 inch) photo paper” on page 78
+ “Set the copy paper type” on page 123

Resize an original to fit onto letter or A4 paper

You can use the Fit to Page feature to copy an original to fit within the printable margins
of a page without the risk of cropping some part of your original. This is useful for reducing
or enlarging an original. For example:

« Ifyouenlarge a 10 x 15 cm (4 x 6 inch) photo to make a borderless full-size copy on
letter or A4 paper, some part of your photo will be cropped. The Fit to Page feature
will enlarge the photo as much as possible to fit the page without cropping any part
of your photo.

« Ifthe image or text on your original fills the entire sheet of paper with no margins, you
can use the Fit to Page feature to reduce your original and prevent unwanted
cropping of the text or images at the edges of the sheet.

= NOTE: In order to resize your original without changing the proportions or cropping
the edges, the HP All-in-One might leave an uneven amount of white space around
the edges of the paper.

To resize a document from the control panel
1. Make sure you have paper loaded in the input tray.
2. Load your original print side down on the right front corner of the glass.
3. Press Copy Menu.
The Copy Menu appears.
4. Press ¥ to highlight Size, and then press OK.
The Size menu appears.
5. Press V¥ to highlight Fit to Page, and then press OK.

Copy

Resize an original using custom settings

You can use your own custom settings to reduce or enlarge a copy of a document.

To set a custom size from the control panel
1. Make sure you have paper loaded in the input tray.
2. Load your original print side down on the right front corner of the glass.
3. Press Copy Menu.
The Copy Menu appears.
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4. Press V¥ to highlight Size, and then press OK.
The Size menu appears.

5. Press V¥ to highlight Custom 100%, and then press OK.
The Custom 100% menu appears.

6. Use the keypad or press ¥ or A to select a percentage to reduce or enlarge the copy.
(The minimum and maximum percentage to resize a copy varies by model.)

7. Press OK.

Crop an original

After changing settings on the HP All-in-One for making a copy, you can use the crop
feature to specify a particular area of the original to copy.

To crop your copy from the control panel

1. Press Copy Menu.
The Copy Menu appears.

2. Change copy settings on the HP All-in-One to accurately reflect the copy you want to
make.

3. Press ¥ to highlight Crop, and then press OK.
The Crop screen appears.

4. Press the arrows on the directional pad to move the cursor to the upper left corner
where you want the crop to begin, and then press OK.

5. Press ¥ and p> to move the cursor to the lower right corner of the crop area, and then
press OK.
The HP All-in-One shows a preview image of the expected output on the display.

6. Press Start Copy Black or Start Copy Color to accept the preview and begin
copying.

Shift the left margin

You can shift the left margin of the copies by using the Margin Shift option. This helps
in binding or 3-hole punching for the copies produced. The HP All-in-One shifts the image
on the copies produced 0.95 cm (3/8 inch) to the right.

B NOTE: When the Margin Shift feature is enabled, the right side of the copy images
may be cropped.

To shift the margin for your copy from the control panel
1. Press Copy Menu.
The Copy Menu appears.

2. Change copy settings on the HP All-in-One to accurately reflect the copy you want to
make.

3. Press ¥ to highlight Margin Shift, and then press OK.
The Margin Shift menu appears.

4. Press ¥ to highlight On, and then press OK.
5. Press Start Copy Black or Start Copy Color to begin copying.

128 Use the copy features



Improve the quality of a copy

You can use the Enhancements feature to adjust the quality of text documents by
sharpening edges of black text or adjust photographs by enhancing light colors that might
otherwise appear white.

The Mixed enhancement is the default option. Use the Mixed enhancement to sharpen
edges of most originals. You can use Photo enhancements to enhance light colors that
might otherwise appear white.

You might be able to fix the following types of issues by changing the Enhancements
setting to Photo or None:

= Stray dots of color surround some text on your copies

« Large, black typefaces look splotchy (not smooth)

« Thin, colored objects or lines contain black sections

* Horizontal grainy or white bands appear in light- to medium-gray areas

To copy a blurred document from the control panel
1. Make sure you have paper loaded in the input tray.
2. Load your original print side down on the right front corner of the glass.
3. Press Copy Menu.
The Copy Menu appears.
4. Press ¥ to highlight Enhancements, and then press OK.
The Enhancements menu appears.
5. Press ¥ to highlight Text, and then press OK.
6. Press Start Copy Black or Start Copy Color.

To copy an overexposed photo
1. Make sure you have paper loaded in the input tray.
2. Position the photo on the glass so the long edge of the photo is along the front edge
of the glass.
Load your original print side down on the right front corner of the glass.
3. Press Copy Menu.
The Copy Menu appears.
4. Press ¥ to highlight Enhancements, and then press OK.
The Enhancements menu appears.
5. Press ¥ to highlight Photo, and then press OK.
6. Press Start Copy Black or Start Copy Color.

Copy

Stop copying

To stop copying
A Press Cancel on the control panel.
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11 Use the fax features

You can use the HP All-in-One to send and receive faxes, including color faxes. You can
set up speed dial entries to send faxes quickly and easily to frequently used numbers.
From the control panel, you can also set a number of fax options, such as resolution and
the contrast between lightness/darkness on the faxes you send.

BY NOTE: Before you begin faxing, make sure you have set up the HP All-in-One
properly for faxing. You might have already done this as part of the initial setup, by
using either the control panel or the software that came with the HP All-in-One.

You can verify the fax is set up correctly by running the fax setup test from the control
panel. You can access this test from the Setup menu.

This section contains the following topics:
* Send a fax

* Receive a fax

» Faxover the Internet using IP phone

+ Stop faxing
Send a fax

You can send a fax in a variety of ways. Using the control panel, you can send a black-
and-white or color fax from the HP All-in-One. You can also send a fax manually from an
attached phone. This allows you to speak with the recipient before sending the fax.
This section contains the following topics:

* Send a basic fax

» Send a fax using speed dials

» Send a fax manually from a phone

» Send a fax using monitor dialing

» Scan a fax to send from memory

» Schedule a fax to send later

» Broadcast a fax to multiple recipients

» Send a color original or photo fax

* Change the fax resolution and Lighter/Darker settings

» Send a fax in Error Correction Mode

Send a basic fax

You can easily send a single- or multiple-page black-and-white fax by using the control
panel, as described here.

Br NOTE: If you need printed confirmation that your faxes were successfully sent,
enable fax confirmation before sending any faxes.
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%+ TIP: You can also send a fax manually from a phone or by using monitor dialing.
" These features allow you to control the pace of your dialing. They are also useful
when you want to use a calling card to charge the call and you need to respond to
tone prompts while dialing.

To send a basic fax from the control panel

1. Load your originals print side up into the document feeder tray. If you are sending a
single-page fax, such as a photograph, you can also load your original print side down
on the glass.

Br NOTE: If you are sending a multiple-page fax, you must load the originals in the
document feeder tray. You cannot fax a multiple-page document from the glass.

2. Press Fax Menu.
Enter the fax number by using the keypad, press A to redial the last number dialed,
or press V¥ to access speed dials.

: To add a pause in the fax number you are entering, press the Symbols
¥ TIP: Toadd in the f. b teri the Symbol
(*) button repeatedly until a dash (-) appears on the display.

3. Press Start Fax Black.

« If the device detects an original loaded in the automatic document feeder,
the HP All-in-One sends the document to the number you entered.

« If the device does not detect an original loaded in the automatic document
feeder, the Feeder Empty prompt appears. Make sure your original is loaded
print side down on the glass, and then press ¥ to highlight Fax original from
scanner glass, and press OK.

4} TIP: If the recipient reports issues with the quality of the fax you sent, you can
try changing the resolution or contrast of your fax.

Related topics

+ “Send a fax manually from a phone” on page 133

* “Send a fax using monitor dialing” on page 134

* “Change the fax resolution and Lighter/Darker settings” on page 137
*  “Print fax confirmation reports” on page 150

+ “Send a color original or photo fax” on page 136

Send a fax using speed dials

You can quickly send a black-and-white or color fax from the HP All-in-One using speed
dials. This section provides instructions for sending the fax in black and white.
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To send a fax using speed dials from the control panel

1. Load your originals print side up into the document feeder tray. If you are sending a
single-page fax, such as a photograph, you can also load your original print side down
on the glass.

B NOTE: If you are sending a multiple-page fax, you must load the originals in the
document feeder tray. You cannot fax a multiple-page document from the glass.

2. Press Fax Menu.

Press ¥ to access speed dials.

4. Press V¥ until the appropriate speed dial entry is highlighted, or enter the speed dial
code by using the keypad on the control panel.
Press OK.

5. Press Start Fax Black.
« If the device detects an original loaded in the automatic document feeder,

the HP All-in-One sends the document to the number you entered.

« If the device does not detect an original loaded in the automatic document
feeder, the Feeder Empty prompt appears. Make sure your original is loaded
print side down on the glass, and then press ¥ to highlight Fax original from
scanner glass, and press OK.

il

{} TIP: If the recipient reports issues with the quality of the fax you sent, you can
try changing the resolution or contrast of your fax.

Related topics
“Set up speed dialing” on page 65

Send a fax manually from a phone

Sending a fax manually allows you to make a phone call and talk with the recipient before
you send the fax. This is useful if you want to inform the recipient that you are going to
send them a fax before sending it. When you send a fax manually, you can hear the dial
tones, telephone prompts, or other sounds through the handset on your telephone. This
makes it easy for you to use a calling card to send your fax.

Depending on how the recipient has their fax machine set up, the recipient might answer
the phone, or the fax machine might take the call. If a person answers the phone, you
can speak with the recipient before sending the fax. If a fax machine answers the call,
you can send the fax directly to the fax machine when you hear the fax tones from the
receiving fax machine.
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To send a fax manually from a connected phone
1. Load your originals print side up into the document feeder tray.

Br NOTE: This feature is not supported if you load your originals on the glass. You
must load your originals in the document feeder tray.

2. Dial the number by using the keypad on the phone that is connected to the HP All-in-
One.

BY NOTE: Do not use the keypad on the control panel of the HP All-in-One. You
must use the keypad on your phone to dial the recipient's number.

3. If the recipient answers the telephone, you can engage in a conversation before
sending your fax.

Br NOTE: If a fax machine answers the call, you will hear fax tones from the
receiving fax machine. Proceed to the next step to transmit the fax.

4. Once you are ready to send the fax, press Start Fax Black or Start Fax Color.
If you were speaking with the recipient before sending the fax, inform the recipient
that they should press Start on their fax machine after they hear fax tones.
The telephone line is silent while the fax is transmitting. At this point, you can hang
up the telephone. If you want to continue speaking with the recipient, remain on the
line until the fax transmission is complete.

Send a fax using monitor dialing

Monitor dialing allows you to dial a number from the control panel as you would dial a
regular telephone. When you send a fax using monitor dialing, you can hear the dial tones,
telephone prompts, or other sounds through the speakers on the HP All-in-One. This
enables you to respond to prompts while dialing, as well as control the pace of your
dialing.

EY NOTE: Make sure the fax volume is turned on, or you will not hear a dial tone.

To send a fax using monitor dialing from the control panel

1. Load your originals print side up into the document feeder tray. If you are sending a
single-page fax, such as a photograph, you can also load your original print side down
on the glass.

2. Press Start Fax Black or Start Fax Color.

3. Once you hear the dial tone, enter the number by using the keypad on the control
panel.

4. Follow any prompts that might occur.

Your fax is sent when the receiving fax machine answers.

Related topics

+ “Adjust the volume” on page 26
+ “Set up speed dialing” on page 65

134 Use the fax features



Scan a fax to send from memory

You can scan a black-and-white fax into memory and then send the fax from memory.
This feature is useful if the fax number you are trying to reach is busy or temporarily

unavailable. The HP All-in-One scans the originals into memory and sends them once it
is able to connect to the receiving fax machine. After the HP All-in-One scans the pages
into memory, you can immediately remove the originals from the document feeder tray.

To scan a fax to send from memory

1.

akrowbd

Load your originals print side up into the document feeder tray. If you are sending a
single-page fax, such as a photograph, you can also load your original print side down
on the glass.

Press the Fax Menu button twice to advance to the Fax Menu.
Press ¥ until Scan and Fax is highlighted, and then press OK.
Enter the fax number by using the keypad.

Press Start Fax Black.

Bf NOTE: If you press Start Fax Color, the fax will be sent in black and white and
a message appears on the display.

The HP All-in-One scans the originals into memory and sends the fax when the
receiving fax machine is available.

Schedule a fax to send later

You can schedule a black-and-white fax to be sent within the next 24 hours. This enables
you to send a black-and-white fax late in the evening, when phone lines are not as busy
or phone rates are lower, for example. The HP All-in-One automatically sends your fax
at the specified time.

You can only schedule one fax to be sent at a time. You can continue to send faxes
normally, however, while a fax is scheduled.

BY NOTE: You cannot schedule a color fax due to memory limitations.

To schedule a fax from the control panel

1.

2.
3.
4

o

Load your originals print side up into the document feeder tray.
Press the Fax Menu button twice to advance to the Fax Menu.
Press ¥ until Send Fax Later is highlighted, and then press OK.

Enter the send time by using the numeric keypad, and then press OK. If prompted,
press 1 for AM, or 2 for PM.

Enter the fax number by using the keypad.
Press Start Fax Black.

The HP All-in-One scans all pages and the scheduled time appears on the display.
The HP All-in-One sends the fax at the scheduled time.
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To cancel a scheduled fax
1. Press the Fax Menu button twice to advance to the Fax Menu.
2. Press ¥ to highlight Send Fax Later and then press OK.
The Fax Is Scheduled screen appears.
3. Press ¥ to highlight Cancel scheduled fax and press OK.

Br NOTE: You can also cancel the scheduled fax by pressing Cancel on the control
panel when the Send Fax Later message is visible on the display.

Broadcast a fax to multiple recipients

You can send a fax to multiple recipients without first setting up a group speed dial.

BY NOTE: The list of recipients you specify for this fax is not saved and only works for
sending faxes in black. If you intend to send other faxes to the same recipient list, you
should create a group speed dial list.

To broadcast a fax to multiple recipients from the control panel
1. Press Fax Menu twice to advance to the Fax Menu screen.
2. Press ¥ to highlight Broadcast Fax, and press OK.
The Enter Fax Number screen appears.
3. Enter the fax number by using the keypad, or press ¥ to access speed dials.

Bf NOTE: You can add up to 20 individual fax numbers.

4. Press Start Fax Black.

5. When prompted, load your originals print side up and top first in the center of the
document feeder tray.

6. Press Start Fax Black again.

Related topics

“Set up group speed dial entries” on page 66

Send a color original or photo fax

You can fax a color original or photo from the HP All-in-One. If the HP All-in-One
determines that the recipient's fax machine only supports black-and-white faxes, the
HP All-in-One sends the fax in black and white.

HP recommends that you use only color originals for color faxing.
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To send a color fax from the control panel

1. Load your originals print side up into the document feeder tray. If you are sending a
single-page fax, such as a photograph, you can also load your original print side down
on the glass.

B NOTE: If you are sending a multiple-page fax, you must load the originals in the
document feeder tray. You cannot fax a multiple-page document from the glass.

2. Enter the fax number by using the keypad.

{} TIP: To add a pause in the fax number you are entering, press the Symbols
(*) button repeatedly until a dash (-) appears on the display.

3. Press Start Fax Color.

« If the device detects an original loaded in the automatic document feeder,
the HP All-in-One sends the document to the number you entered.

« If the device does not detect an original loaded in the automatic document
feeder, the Feeder Empty prompt appears. Make sure your original is loaded
print side down on the glass, and then press ¥ to highlight Fax original from
scanner glass, and press OK.

= NOTE: Ifthe recipient's fax machine only supports black-and-white faxes, the HP All-
in-One automatically sends the fax in black and white. A message appears after the
fax has been sent indicating that the fax was sent in black and white. Press OK to
clear the message.

Change the fax resolution and Lighter/Darker settings

You can change the Resolution and Lighter/Darker settings for documents that you are
faxing.

BY NOTE: These settings do not affect copy settings. Copy resolution and lightness/
darkness are set independently from fax resolution and lightness/darkness. Also, the
settings that you change from the control panel do not affect faxes you send from your
computer.

This section contains the following topics:
* Change the fax resolution

* Change the Lighter/Darker setting

* Set new default settings

Change the fax resolution

The Resolution setting affects the transmission speed and quality of faxed black-and-
white documents. If the receiving fax machine does not support the resolution you have
chosen, the HP All-in-One sends faxes at the highest resolution supported by the
receiving fax machine.

BY NOTE: You can only change the resolution for faxes that you are sending in black
and white. The HP All-in-One sends all color faxes using Fine resolution.

Send a fax 137



Chapter 11

The following resolution settings are available for sending faxes: Fine, Very Fine,
Photo, and Standard.

* Fine: provides high-quality text suitable for faxing most documents. This is the default
setting. When sending faxes in color, the HP All-in-One always uses the Fine setting.

+ Very Fine: provides the best quality fax when you are faxing documents with very
fine detail. If you choose Very Fine, be aware that the faxing process takes longer to
complete and you can only send black-and-white faxes using this resolution. If you
send a color fax, it will be sent using Fine resolution instead.

+  Photo: provides the best quality fax when sending photographs in black and white.
If you choose Photo, be aware that the faxing process takes longer to complete.
When faxing photographs in black and white, HP recommends that you choose
Photo.

« Standard: provides a lower quality fax so that the faxing process will take less time
to complete.

When you exit the Fax menu, this option returns to the default setting unless you set your
changes as the default.

To change the resolution from the control panel
1. Press Fax Menu.
The Enter Fax Number screen appears.
2. Enter the fax number by using the keypad, press A to redial the last number dialed,
or press V¥ to access speed dials.
3. Press Fax Menu again.
The Fax Menu appears.
4. Press ¥ to highlight Resolution, and then press OK.
Press ¥ to highlight a resolution setting, and then press OK.
5. Press Start Fax Black.

BY NOTE: If you press Start Fax Color, the fax will be sent using the Fine setting.

6. When prompted, load your originals print side up and top first in the center of the
document feeder tray.

7. Press Start Fax Black again.

Related topics
“Set new default settings” on page 139

Change the Lighter/Darker setting

You can change the contrast of a fax to be darker or lighter than the original. This feature
is useful if you are faxing a document that is faded, washed out, or handwritten. You can
darken the original by adjusting the contrast.

Bf NOTE: The Lighter/Darker setting applies to black and white faxes only, not color
faxes.

When you exit the Fax menu, this option returns to the default setting unless you set your
changes as the default.
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To change the Lighter/Darker setting from the control panel
1. Press Fax Menu.
The Enter Fax Number screen appears.

2. Enter the fax number by using the keypad, press A to redial the last number dialed,
or press V¥ to access speed dials.

3. Press Fax Menu again.
The Fax Menu appears.
4. Press ¥ to highlight Lighter/Darker, and then press OK.
The Lighter/Darker menu appears.
5. Press 4o lighten the fax or press p> to darken it.
The indicator moves to the left or right as you press an arrow.
6. Press Start Fax Black.

7. When prompted, load your originals print side up and top first in the center of the
document feeder tray.

8. Press Start Fax Black again.

Related topics
“Set new default settings” on page 139

Set new default settings

You can change the default value for the Resolution and Lighter/Darker settings
through the control panel.

To set new default settings from the control panel
1. Press Fax Menu until the Fax Menu appears.
You might need to press Fax Menu more than once to display this menu.
2. Make your changes to Resolution and Lighter/Darker.
3. Press ¥ to highlight Set As New Defaults, and then press OK.

Send a fax in Error Correction Mode

Error Correction Mode (ECM) prevents loss of data due to poor phone lines by detecting
errors that occur during transmission and automatically requesting retransmission of the
erroneous portion. Phone charges are unaffected, or might even be reduced, on good
phone lines. On poor phone lines, ECM might increase sending time and phone charges,
but sends the data much more reliably. The default setting is On. Turn ECM off only if it
increases phone charges substantially, and you can accept poorer quality in exchange
for reduced charges.

Before turning the ECM setting off, consider the following. If you turn ECM off

« The quality and transmission speed of faxes you send and receive are affected.
« The Fax Speed is automatically set to Medium (14400).
* You will no longer be able to send or receive faxes in color.
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To change the ECM setting from the control panel

1. Press Setup.

2. Press ¥ to highlight Advanced Fax Setup, and then press OK.
The Advanced Fax Setup menu appears.

3. Press ¥ to highlight Error Correction Mode, and then press OK.
The Error Correction Mode menu appears.

4. Press ¥ to highlight Off or On.

5. Press OK.

Receive a fax

The HP All-in-One can receive faxes automatically or manually. If you turn off the Auto
Answer option, you will need to receive faxes manually. If you turn on the Auto
Answer option (the default setting), the HP All-in-One automatically answers incoming
calls and receives faxes after the number of rings specified by the Rings to Answer
setting. (The default Rings to Answer setting is five rings.)

You can receive faxes manually from a phone that is:

+ Directly connected to the HP All-in-One (on the 2-EXT port)

+  On the same telephone line, but not directly connected to the HP All-in-One

If you receive a legal-size fax and the HP All-in-One is not currently set to use legal-size
paper, the device reduces the fax so that it fits on the paper that is loaded in the HP All-

in-One. If you have disabled the Automatic Reduction feature, the HP All-in-One might
print the fax on more than one page.

This section contains the following topics:

* Receive a fax manually

+ Set up backup fax reception

* Reprint received faxes from memory

+ Poll to receive a fax

» Forward faxes to another number

» Set the paper size for received faxes

» Set up the HP All-in-One to check the paper type before printing faxes
» Set automatic reduction for incoming faxes

» Block junk fax numbers

Receive a fax manually

When you are on the phone, the person you are speaking with can send you a fax while
you are still connected. This is referred to as manual faxing. Use the instructions in this
section to receive a manual fax.

You can receive faxes manually from a phone that is:

» Directly connected to the HP All-in-One (on the 2-EXT port)
*  On the same phone line, but not directly connected to the HP All-in-One
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To receive a fax manually
1. Make sure the HP All-in-One is turned on and you have paper loaded in the input tray.
2. Remove any originals from the document feeder tray.

3. Setthe Rings to Answer setting to a high number to allow you to answer the incoming
call before the HP All-in-One answers. Or, turn off the Auto Answer setting so that
the HP All-in-One does not automatically answer incoming calls.

4. |If you are currently on the phone with the sender, instruct the sender to press Start
on their fax machine.

5. When you hear fax tones from a sending fax machine, do the following:
a. Press Start Fax Black or Start Fax Color on the control panel of the HP All-in-

One.

b. When prompted, press ¥ to highlight Receive Fax Manually, and then press

OK.

6. Press Start Fax Black again.

7. Afterthe HP All-in-One begins to receive the fax, you can hang up the phone or remain
on the line. The phone line is silent during fax transmission.

Related topics

+ “Set the number of rings before answering” on page 62

* “Set the answer mode” on page 62

Set up backup fax reception

Depending on your preference and security requirements, you can set up the HP All-in-
One to store all the faxes it receives, only the faxes it receives while the device is in an
error condition, or none of the faxes it receives.

The following Backup Fax Reception modes are available:

On

The default setting. When Backup Fax Reception is On, the HP All-in-One
stores all faxes it receives in memory. This enables you to reprint one or all
of the most recently printed faxes if they are still saved in memory.

NOTE: When the memory gets low, the HP All-in-One overwrites the
oldest, printed faxes as it receives new faxes. If the memory becomes full
of unprinted faxes, the HP All-in-One will stop answering incoming fax calls.

NOTE: If you receive a fax that is too large, such as a very detailed color
photo, it might not be stored in memory due to memory limitations.

On Error Only

Causes the HP All-in-One to store faxes in memory only if there is an error
condition that prevents the HP All-in-One from printing the faxes (for
example, if the HP All-in-One runs out of paper). The HP All-in-One will
continue to store incoming faxes as long as there is memory available. (If
the memory becomes full, the HP All-in-One will stop answering incoming
fax calls.) When the error condition is resolved, the faxes stored in memory
print automatically and are then deleted from memory.

Off

Means that faxes are never stored in memory. (You might want to turn off
Backup Fax Reception for security purposes, for example.) If an error
condition occurs that prevents the HP All-in-One from printing (for example,
the HP All-in-One runs out of paper), the HP All-in-One will stop answering
incoming fax calls.
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B NOTE: If Backup Fax Reception is enabled and you turn off the HP All-in-One, all

faxes stored in memory are deleted, including any unprinted faxes that you might have
received while the HP All-in-One was in an error condition. You will need to contact
the senders to ask them to resend any unprinted faxes. For a list of the faxes you
have received, print the Fax Log. The Fax Log is not deleted when the HP All-in-One
is turned off.

To set backup fax reception from the control panel

1.
2,

w

ok

Press Setup.

Press ¥ to highlight Advanced Fax Setup, and then press OK.
The Advanced Fax Setup menu appears.

Press ¥ to highlight Backup Fax Reception, and then press OK.
The Backup Fax Reception menu appears.

Press P to highlight On, On Error Only, or Off.

Press OK.

Related topics
“Reprint received faxes from memory” on page 142

Reprint received faxes from memory

142

If you set the Backup Fax Reception mode to On, the HP All-in-One stores faxes it
receives in memory, whether the device has an error condition or not.

B NOTE: After the memory becomes full, the HP All-in-One overwrites the oldest,

printed faxes as it receives new faxes. If all the stored faxes are unprinted, the HP All-
in-One will not receive any more fax calls until you print or delete the faxes from
memory. You might also want to delete the faxes in memory for security or privacy
purposes.

You can choose to reprint one or reprint all faxes in memory. For example, you might
need to reprint your faxes if you lost the copy of your last printout.

To reprint faxes in memory from the control panel

1.
2,
3.

Make sure you have paper loaded in the input tray.

Press Setup.

Press ¥ to highlight Tools, and then press OK.

The Tools menu appears.

Press ¥ to highlight Reprint Faxes in Memory, and then press OK.
The Reprint menu appears.

Do one of the following:

To reprint one fax from memory

a. Press ¥ to highlight One Fax, and then press OK.
The Select Fax menu appears.

b. Press ¥ to highlight a fax number, and then press OK.
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To reprint all faxes in memory
A Press V¥ to highlight All faxes in memory, and then press OK.
6. If you want to stop reprinting the faxes in memory, press Cancel.

To delete all the faxes in memory from the control panel
1. Press Setup.
2. Press ¥ to highlight Tools, and then press OK.
The Tools menu appears.
3. Press ¥ to highlight Clear Fax Log, and then press OK.

BY NOTE: You can also delete any faxes stored in memory by turning off the HP All-in-
One. Press the On button to turn off the HP All-in-One. All faxes stored in memory
will be deleted from memory when you turn off the power to the HP All-in-One.

Related topics
“Set up backup fax reception” on page 141

Poll to receive a fax

Polling allows the HP All-in-One to ask another fax machine to send a fax that it has in
its queue. When you use the Poll to Receive feature, the HP All-in-One calls the
designated fax machine and requests the fax from it. The designated fax machine must
be set for polling and have a fax ready to send.

Bf NOTE: The HP All-in-One does not support polling pass codes. Polling pass codes
are a security feature that require the receiving fax machine to provide a pass code
to the device it is polling in order to receive the fax. Make sure the device you are
polling does not have a pass code set up or the HP All-in-One will not be able to
receive the fax.

To set up poll to receive a fax from the control panel

1. Press the Fax Menu button twice to advance to the Fax Menu.
2. Press ¥ to highlight Poll to Receive, and then press OK.

3. When prompted, enter the fax number of the other fax machine.
4. Press Start Fax Black or Start Fax Color.

B NOTE: If you press Start Fax Color but the sender sent the fax in black and
white, the HP All-in-One prints the fax in black and white.

Forward faxes to another number

You can set up the HP All-in-One to forward your faxes to another fax number. If you
receive a color fax, the HP All-in-One forwards the fax in black and white.

HP recommends that you verify the number you are forwarding to is a working fax line.
Send a test fax to make sure the fax machine is able to receive your forwarded faxes.
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To forward faxes from the control panel
1. Press Setup.
2. Press ¥ to highlight Advanced Fax Setup, and then press OK.
The Advanced Fax Setup menu appears.
3. Press ¥ to highlight Fax Forwarding, and then press OK.
The Fax Forwarding menu appears.
4. Press V¥ until On-Forward or On-Print & Forward appears, an